CS3000   MMI   SW-Version 6.1
Control and Configuration Software
for FlexPak3000 V2.0 - 4.3,
GV3000 V2.0 - 6.0 and Liqui-Flo

Instruction Manual
The information in this manual is subject to change without notice.

Throughout this manual, the following notes are used to alert you to safety considerations:

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss.

**Important:** Identifies information that is critical for successful application and understanding of the product.

The thick black bar shown on the outside margin of this page will be used throughout this instruction manual to signify new or revised text or figures.

**ATTENTION:** Only qualified electrical personnel familiar with the construction and operation of this equipment and the hazards involved should install, operate, or service this equipment. Read and understand this manual and other applicable manuals in their entirety before proceeding. Failure to observe this precaution could result in severe bodily injury or loss of life.

**ATTENTION:** Only qualified personnel should develop or change drive configuration. Read and understand the drive instruction manual in its entirety before proceeding with configuration edit. Failure to observe this precaution could result in severe bodily injury or loss of life.

**ATTENTION:** Parameter assignments made while the software in controlling and communicating to the drive overwrite the parameter values in the drive. Read and understand this manual and all other applicable manuals in their entirety before changing drive parameter values. Failure to observe this precaution could result in severe bodily injury or loss of life.

IBM is a trademark of International Business Machine Corporation. Microsoft, Windows, and MS-DOS are trademarks of Microsoft Corporation. Pentium is a trademark of Intel Corporation. GV3000, Liqui-Flo, FlexPak, and Reliance are trademarks of Rockwell Automation. ©1999 Rockwell International Corporation
Chapter 1 Introduction
1.1 About the Control and Configuration Software ................................................ 1-1
1.2 Software Requirements ................................................................................... 1-1
1.3 Hardware Requirements.................................................................................. 1-2
1.4 Cables ............................................................................................................. 1-2
1.5 Safety Information ........................................................................................... 1-3
1.6 Purpose of This Manual................................................................................... 1-3
1.7 Intended Audience........................................................................................... 1-3
1.8 Terms Used in This Manual............................................................................. 1-4
1.9 Where to Find Additional Information .............................................................. 1-4

Chapter 2 Getting Started
2.1 Before Installing the Software.......................................................................... 2-1
2.2 Installing the CS3000 Software on a Personal Computer ............................... 2-2
2.3 Setting Up Communication Between the CS3000 Software and the Drive .... 2-3
   2.3.1 Connecting the Personal Computer’s Serial Port to the Drive .............. 2-3
   2.3.2 Setting Up the Drive to Communicate with the Personal Computer..... 2-5
   2.3.3 Selecting the Correct Communication Port ........................................... 2-5
2.4 Starting the Software ....................................................................................... 2-5
2.5 About the Menus and Toolbars ....................................................................... 2-7
   2.5.1 About the Menus ................................................................................... 2-7
   2.5.2 About the Toolbar.................................................................................. 2-8
2.6 Exiting the CS3000 Software......................................................................... 2-10

Chapter 3 Configuring the Drive
3.1 Selecting a Drive ............................................................................................. 3-1
3.2 Creating a New Configuration ......................................................................... 3-2
3.3 Opening a Drive Configuration File ................................................................. 3-3
3.4 Opening a Configuration File for a Different Version of the Same Drive ..... 3-5
3.5 Editing a Configuration .................................................................................... 3-7
   3.5.1 Assigning Parameter Values ................................................................. 3-7
   3.5.2 Ending an Editing Session ................................................................... 3-9
   3.5.3 Entering and Editing a Configuration Description ................................ 3-9
3.6 Saving a Drive Configuration.......................................................................... 3-10
3.7 Saving the Open Drive Configuration to Another File................................. 3-11
3.8 Printing a Configuration ............................................................................... 3-12

Chapter 4 Uploading and Downloading Drive Configurations
4.1 Uploading a Drive Configuration........................................................................ 4-1
4.2 Downloading a Configuration to the Drive ...................................................... 4-2
4.3 Comparing the Drive Configuration to the Opened Configuration .............. 4-3
4.4 Comparing the Parameter Values in the Opened Configuration with Those in Another Configuration File ......................................................... 4-4
<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Tuning GV3000 and Liqui-Flo Vector Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Saving the Drive Configuration Before Tuning</td>
</tr>
<tr>
<td>5.2</td>
<td>Using Standard Tuning</td>
</tr>
<tr>
<td>5.3</td>
<td>Using Custom Tuning</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Setting Motor Data</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Tuning the Torque/Flux Loop</td>
</tr>
<tr>
<td>5.3.3</td>
<td>Tuning the Speed Loop</td>
</tr>
<tr>
<td>5.3.4</td>
<td>Using Profile To Check Drive Tuning</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Monitoring and Editing Drive Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>About the Parameter Monitor</td>
</tr>
<tr>
<td>6.2</td>
<td>Adding Parameters to the Monitor List</td>
</tr>
<tr>
<td>6.3</td>
<td>Removing Parameters from the Monitor List</td>
</tr>
<tr>
<td>6.4</td>
<td>Assigning Values to Parameters on the Drive</td>
</tr>
<tr>
<td>6.5</td>
<td>Saving a Monitor List</td>
</tr>
<tr>
<td>6.6</td>
<td>Displaying a Monitor List</td>
</tr>
<tr>
<td>6.7</td>
<td>Clearing the Monitor List Display</td>
</tr>
<tr>
<td>6.8</td>
<td>Exiting the CS3000 Parameter Monitor</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Monitoring Drive Status and Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Displaying and Clearing the Fault Log and Alarm Log</td>
</tr>
<tr>
<td>7.2</td>
<td>Monitoring Drive Status</td>
</tr>
<tr>
<td>7.3</td>
<td>Restoring Default Values to Drive Parameters</td>
</tr>
<tr>
<td>7.4</td>
<td>Saving Drive Parameter Values to Non-Volatile Memory on the Drive</td>
</tr>
<tr>
<td>7.5</td>
<td>Restoring Drive Parameter Values from Non-Volatile Memory in the Drive</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8</th>
<th>Controlling the Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>Connecting a Drive</td>
</tr>
<tr>
<td>8.2</td>
<td>Disconnecting a Drive</td>
</tr>
<tr>
<td>8.3</td>
<td>Controlling a Drive</td>
</tr>
<tr>
<td>8.4</td>
<td>Selecting the Control Source</td>
</tr>
<tr>
<td>8.5</td>
<td>Selecting the Reference Mode (Auto/Manual)</td>
</tr>
<tr>
<td>8.6</td>
<td>Selecting the Direction of Motor Rotation</td>
</tr>
<tr>
<td>8.7</td>
<td>Setting the Drive Reference</td>
</tr>
<tr>
<td>8.8</td>
<td>Setting the Jog Reference</td>
</tr>
<tr>
<td>8.9</td>
<td>Starting and Stopping the Drive</td>
</tr>
<tr>
<td>8.10</td>
<td>Monitoring Drive Indicators</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Using PC Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
<td>About PC Scope</td>
</tr>
<tr>
<td>9.2</td>
<td>Setting Up a Trace</td>
</tr>
<tr>
<td>9.2.1</td>
<td>Specifying Signals</td>
</tr>
<tr>
<td>9.2.2</td>
<td>Setting Up Data Sampling</td>
</tr>
<tr>
<td>9.2.3</td>
<td>Setting Up the Trigger</td>
</tr>
<tr>
<td>9.3</td>
<td>Acquiring a Trace</td>
</tr>
<tr>
<td>9.4</td>
<td>Working with the Cursors</td>
</tr>
<tr>
<td>9.4.1</td>
<td>Moving a Cursor</td>
</tr>
<tr>
<td>9.4.2</td>
<td>Specifying the Cursors To Track Each Other</td>
</tr>
<tr>
<td>9.5</td>
<td>Changing Views</td>
</tr>
<tr>
<td>9.5.1</td>
<td>Turning Cursors On and Off</td>
</tr>
<tr>
<td>9.5.2</td>
<td>Magnifying the Trace Display</td>
</tr>
<tr>
<td>9.6</td>
<td>Taking a Trace Snapshot</td>
</tr>
<tr>
<td>9.6.1</td>
<td>Taking a Snapshot</td>
</tr>
</tbody>
</table>
Figure 2.1 – RS-232 Cable Connector Pinouts for Drives with a 9-Pin Connector... 2-4
Figure 2.2 – RS-232 Cable Connector Pinouts for Drives with a Terminal Block Connector ........................................................................................................ 2-4
Figure 2.3 – RS-232 Cable Connector Pinouts for Drives with a 25-Pin Connector ..................................................................................................................... 2-5
Figure 2.4 – Sample Main Window for an Established Connection.............. 2-6
Figure 2.5 – Graphical Tool Bar................................................................................ 2-8

Figure 3.1 – Drive Select—Disconnected................................................................. 3-1
Figure 3.2 – File New Window.................................................................................. 3-2
Figure 3.3 – Open Configuration File Dialog Box ..................................................... 3-3
Figure 3.4 – Configuration Editor.............................................................................. 3-7
Figure 3.5 – Configuration Description Dialog Box................................................... 3-9
Figure 3.6 – Configuration Description Pop-Up Edit Menu..................................... 3-10
Figure 3.7 – Save Configuration Dialog Box........................................................... 3-11
Figure 3.8 – Sample Configuration File Printout..................................................... 3-12

Figure 4.1 – Compare Configuration File Dialog Box ............................................... 4-4
Figure 4.2 – Configuration Differences Dialog Box................................................... 4-5

Figure 5.1 – Drive Tuning Menu ............................................................................... 5-1
Figure 5.2 – Example of Motor Data Dialog Box ...................................................... 5-2
Figure 5.3 – Example of Setting Motor Data Values................................................. 5-4
Figure 5.4 – Example of Setting Torque/Flux Loop Data Values.............................. 5-5
Figure 5.5 – Example of Setting Speed Loop Data Values ...................................... 5-6
Figure 5.6 – Drive Profile Example ........................................................................... 5-7

Figure 6.1 – Parameter Monitor Window .................................................................. 6-2
Figure 6.2 – Add Parameters to Monitor List Dialog Box.......................................... 6-3
Figure 6.3 – Save Monitor List Dialog Box ............................................................... 6-6
Figure 6.4 – Recall Monitor List Dialog Box.............................................................. 6-7
Figure 6.5 – Remove Parameters from Monitor List Dialog Box.............................. 6-8

Figure 7.1 – Sample Fault Log List Box.................................................................... 7-1
Figure 7.2 – Sample Alarm Log List Box .................................................................. 7-2
Figure 7.3 – Drive Status Window ............................................................................ 7-4

Figure 8.1 – Drive Control Window........................................................................... 8-3

Figure 9.1 – The PC Scope Screen.......................................................................... 9-2
Figure 9.2 – Trace Signal Setup Dialog Box............................................................. 9-4
Figure 9.3 – Sample Trace ....................................................................................... 9-8
Figure 9.4 – Save a Signal Trace File Dialog Box.................................................... 9-11
Figure 9.5 – Open Signal Trace File Dialog Box ..................................................... 9-12
List of Tables

Table 1.1 – Cables................................................................................................................. 1-2
Table 1.2 – Terms.................................................................................................................... 1-4

Table 2.1 – Overview of the Menu......................................................................................... 2-7
Table 2.2 – Toolbar Icons and Menus ................................................................................... 2-9

Table 3.1 – Editing Configuration Descriptions....................................................................... 3-10

Table 4.1 – Compare Dialog Box Functions........................................................................... 4-3
Table 4.2 – Configuration Differences Dialog Box Options ................................................. 4-5

Table 7.1 – Using the Fault and Alarm Logs .......................................................................... 7-3
Table 7.2 – Drive Status Indicators......................................................................................... 7-5

Table 9.1 – PC Scope Toolbar Buttons..................................................................................... 9-3
1.1 About the Control and Configuration Software

Use the Control and Configuration (CS3000) software to help you develop drive configurations on your personal computer for GV3000™, Liqui-Flo™, and FlexPak™ 3000 drives. The CS3000 software communicates with the drive through the personal computer’s RS-232 port.

By using the CS3000 software, you can:

• Create, store, upload, download, and print drive configurations.
• Monitor drive status.
• Monitor and change drive parameters using a personal computer.
• Control the drive (start, stop, etc.).
• Compare a configuration in the drive with one in the personal computer.
• Read and reset the drive fault and error log.
• Create, modify, and store drive configurations.
• Send Memory Save, Memory Restore, and Restore Defaults commands to a drive.
• Display trace signals in the drive.

1.2 Software Requirements

The CS3000 software requires Microsoft Windows™ 3.1 or later versions (including Windows 98 or Windows NT). Make sure Windows is installed and configured on your personal computer before attempting to install the CS3000 software.
1.3 **Hardware Requirements**

Before installing and using the CS3000 software make sure you have the following hardware:

- An IBM or IBM-compatible 486 or Pentium personal computer running Windows 3.1, Windows 98, or Windows NT.
- 16 Mbytes of RAM (minimum)
- A hard drive with at least 1 Mbytes free space available for the CS3000 software
- A 3.5" floppy drive
- A Monochrome or color monitor: VGA or better
- An RS-232 serial COM port for communicating with the drive
- An RS-232 serial cable with:
  - A 25-pin or 9-pin D-shell connector for your personal computer
  - A 9-pin or 25-pin male D-shell connector for the drive.

The GV3000 drive is equipped with a terminal strip as well as a 9-pin D-shell connector. Either one can be used to connect to the personal computer. Refer to section 2.3.1 for additional information.

1.4 **Cables**

The Interface cable can be used to connect the personal computer to the drive.

The Adapter is required, if your personal computer has a 25-pin COM port and you want to use one of the specified Interface cables.

<table>
<thead>
<tr>
<th>Drive</th>
<th>Drive Connector</th>
<th>PC Connector</th>
<th>Interface Cable</th>
<th>Adapter</th>
<th>Cable Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlexPak3000</td>
<td>25-pin</td>
<td>9-pin 25-pin</td>
<td>25-pin to 9-pin</td>
<td>25-pin to 9-pin</td>
<td>772.27.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>772.27.20</td>
</tr>
<tr>
<td>GV3000</td>
<td>9-pin</td>
<td>9-pin 25-pin</td>
<td>9-pin to 9-pin</td>
<td>25-pin to 9-pin</td>
<td>772.27.10</td>
</tr>
<tr>
<td>Liqui-Flo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>772.27.20</td>
</tr>
</tbody>
</table>
1.5 Safety Information

ATTENTION: Do not run other Windows or DOS software applications while you are using the CS3000 software for drive control. Unexpected machine motion could result. Failure to observe this precaution could result in severe bodily injury or loss of life.

The CS3000 software operates as a Windows 3.1 application. It cannot preempt other applications or functions in Windows and, therefore, cannot guarantee a response time to user input actions. Using other applications while controlling a drive with the CS3000 software can tie up PC resources and cause drive commands to be delayed. To prevent drive commands (run, stop, and jog) from unexpectedly executing, the CS3000 software specifies a time-out period (approximately 2 seconds) when it establishes a link with the drive. While the link is established, the CS3000 software sends messages to the drive to validate the link. If a message fails to reach the drive within the time-out period because program execution has been delayed, the drive invalidates the link. If the link becomes invalid, the drive does not accept drive commands. If the drive was running, it stops, and a serial fault is generated.

Before a drive control command is sent to the drive, the drive’s status is checked to validate the link. If communication between the CS3000 software and the drive have been interrupted and you have selected a drive command, the command is not sent and a message is displayed.

The time-out period is also used by the Parameter Monitor and Download functions, both of which could be running while the Drive Control Window is open. If the link becomes invalid while these functions are running, a message will be displayed in the Drive Control window before the link is re-established. When you select the Download command while the Drive Control window is open, you cannot execute drive command controls until the download is complete.

1.6 Purpose of This Manual

This manual describes how to use the Control and Configuration software (CS3000) to configure GV3000, Liqui-Flo, and FlexPak 3000 drives. Refer to the appropriate drive instruction manual for information about parameters and RS-232 connection options.

1.7 Intended Audience

This manual is written for those who must install the CS3000 software and use the software to configure and run GV3000, Liqui-Flo, and FlexPak drives. This manual assumes you are familiar with Windows and makes references to it throughout.

You will need to know the basic Windows functions before using the CS3000 software.
1.8 Terms Used in This Manual

The following terms are used throughout this manual:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS3000</td>
<td>Control and Configuration</td>
</tr>
<tr>
<td>COM port</td>
<td>communication port</td>
</tr>
<tr>
<td>configuration file</td>
<td>drive configurations stored on the personal computer that can only be read and written to by the CS3000 software</td>
</tr>
<tr>
<td>disk drive</td>
<td>the personal computer's 3.5 inch disk drive</td>
</tr>
<tr>
<td>drive</td>
<td>the Power Module and regulator combination that controls a motor</td>
</tr>
<tr>
<td>drive configuration</td>
<td>the set of drive parameters and assignment values that specify how the drive runs</td>
</tr>
<tr>
<td>hard drive</td>
<td>the personal computer’s hard disk drive</td>
</tr>
<tr>
<td>opened configuration</td>
<td>the configuration that is active in the CS3000 software</td>
</tr>
</tbody>
</table>

1.9 Where to Find Additional Information

See the following instruction manuals for more information about the drives that can be configured using the CS3000 software:

- GV3000 AC Drive Instruction Manuals
- Liqui-Flo AC Drive Instruction Manuals
- FlexPak 3000 DC Drive Instruction Manuals
This section describes how to install the CS3000 software and use the menus and toolbars.

2.1 Before Installing the Software

If you have an older version of the CS3000 software on your PC, you should either:

- delete the old version before installing the new version

  Keep any working files such as, the drive configuration and monitor list files, for use with the new version of the CS3000 software

- install the new version of CS3000 software in a new directory

  You can select the new directory name during installation. If you choose this option, change the name of the program folder for the old version of the CS3000 software to a name other than CS3000, such as “CS3000, V 5.0.” Otherwise, the new version will replace the old version in that program group, although it will not overwrite any of the files on the hard drive. See your Windows documentation for more information about changing the name of a program group.

Before installing the new CS3000 software, back up the files to another floppy disk.

See your Windows documentation for instructions about using the File Manager or Explorer to copy disks.
### 2.2 Installing the CS3000 Software on a Personal Computer

All files needed to install the CS3000 software are on the 3.5” CS3000 disk. Use the following steps to install the CS3000 software.

**Important:** To exit installation, select the Exit icon in the lower right corner or press F3

Step 1. Start Microsoft Windows.

Step 2. Insert the CS3000 software disk into the 3.5” floppy drive.

Step 3. Follow the steps for operating the system you are using:

<table>
<thead>
<tr>
<th>Windows 3.1</th>
<th>Windows 98 or NT</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. From the Program Manager menu bar, select File.</td>
<td>a. From the Start Menu, select Run.</td>
</tr>
<tr>
<td>b. Select Run.</td>
<td>b. In the Open field, type in the drive letter followed by SETUP. For example, if your 3.5” floppy drive is A:, you would type A:SETUP.</td>
</tr>
<tr>
<td>c. In the Command Line field, type in the drive letter followed by \SETUP.EXE. For example, if your 3.5” floppy drive is A:, you would type A:\SETUP.EXE.</td>
<td>The message “Setup is initializing. Please wait . . .” is displayed for about a minute.</td>
</tr>
<tr>
<td>d. Select OK. The message “Setup is initializing. Please wait . . .” is displayed for about a minute.</td>
<td></td>
</tr>
</tbody>
</table>

Step 4. At the prompt “Enter location for Control and Configuration Software program files,” specify the location where you want to install the software. The location defaults to C:\CS3000. Select OK when the drive and directory are correct. The installation software automatically creates the new directory on the hard drive you enter.

Step 5. At the prompt “Enter desired default location for Control and Configuration Software work files,” specify the location where you want to store the drive configuration files. The default location is C:\CS3000\WORK. Select OK when the drive and directory are correct.

The program begins its installation sequence. You see the following messages during installation:

- “Decompressing Control and Configuration Software files . . .” for about a minute, then
- “Creating Program Group and Icon” for a few seconds
After creating the program group and icon, the CS3000 software installation is complete. The installation program automatically exits, and you return to Windows. You should see a new program group titled “Control and Configuration.”

Step 6. Remove the CS3000 disk from the 3.5” drive.

The CS3000 software is now installed and ready to use.

If you had an older version of the CS3000 software installed, you can use the configuration and monitor files you created with that version. To make it easier to use the existing configuration and monitor files, move them to the working directory of the new version of software. The working directory is normally C:\CS3000\WORK. Configuration files typically have file extensions of .CNF; monitor files typically have .MON file extensions. See the Windows documentation for information about moving files.

2.3 Setting Up Communication Between the CS3000 Software and the Drive

The following sections describe the setup required for communication between the CS3000 software and the drive. To enable communication between the CS3000 software and the drive:

- Physically connect the personal computer to the drive through a serial port connection (see section 2.3.1)
- Set up the drive for communication through a serial port (see section 2.3.2)
- Select the correct communication port on the personal computer (see section 2.3.3)

2.3.1 Connecting the Personal Computer's Serial Port to the Drive

For the CS3000 software to communicate with the drive, connect the personal computer to the drive using an appropriate cable by following these instructions:

Step 1. The drive's RS-232 port typically uses a 9-pin or 25-pin female D-shell connector. Connect the communication cable's 9-pin or 25-pin male connector to the drive. Refer to the drive instruction manual for the location of the RS-232 port on the drive.

Step 2. Connect the other end of the communication cable to the personal computer's COM1 port. If the COM1 port is not available, refer to section 2.3.3 for information about selecting the correct communication port. The personal computer COM port might have either a 25-pin or a 9-pin connector. Refer to figures 2.1 through 2.3 for cable connector and pinout signals for 9-pin and 25-pin configurations.
<table>
<thead>
<tr>
<th>Personal Computer</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>25-pin Female</strong></td>
<td><strong>9-pin Male</strong></td>
</tr>
<tr>
<td>Data OUT</td>
<td>3 - Data IN</td>
</tr>
<tr>
<td>Data IN</td>
<td>2 - Data OUT</td>
</tr>
<tr>
<td>Ground</td>
<td>7 - Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Personal Computer</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>9-pin Female</strong></td>
<td><strong>9-pin Male</strong></td>
</tr>
<tr>
<td>Data OUT</td>
<td>3 - Data IN</td>
</tr>
<tr>
<td>Data IN</td>
<td>2 - Data OUT</td>
</tr>
<tr>
<td>Ground</td>
<td>5 - Ground</td>
</tr>
</tbody>
</table>

Figure 2.1 – RS-232 Cable Connector Pinouts for Drives with a 9-Pin Connector

<table>
<thead>
<tr>
<th>Personal Computer</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>25-pin Female</strong></td>
<td><strong>Terminal</strong></td>
</tr>
<tr>
<td>Data OUT</td>
<td>3 - Data IN</td>
</tr>
<tr>
<td>Data IN</td>
<td>2 - Data OUT</td>
</tr>
<tr>
<td>Ground</td>
<td>7 - Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Personal Computer</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>9-pin Female</strong></td>
<td><strong>Terminal</strong></td>
</tr>
<tr>
<td>Data OUT</td>
<td>3 - Data IN</td>
</tr>
<tr>
<td>Data IN</td>
<td>2 - Data OUT</td>
</tr>
<tr>
<td>Ground</td>
<td>5 - Ground</td>
</tr>
</tbody>
</table>

Figure 2.2 – RS-232 Cable Connector Pinouts for Drives with a Terminal Block Connector
2.3.2 Setting Up the Drive to Communicate with the Personal Computer

For the CS3000 software to communicate with the drive, the drive’s operation control source parameter must be set up properly. For the GV3000, Liqui-Flo, or FlexPak 3000 drive, set parameter P.000 to specify serial communication. Refer to the appropriate drive instruction manual for more information.

2.3.3 Selecting the Correct Communication Port

The CS3000 software communicates with the drive through the personal computer’s serial port. The software defaults to the COM1 port. If COM1 is already being used, you must select another COM port. To change the COM port:

Step 1. Start the CS3000 software.
Step 2. From the Options menu, select COM.
Step 3. Select the appropriate COM port from the options displayed in the dialog box.
Step 4. Select OK when the correct COM port is selected. This returns you to the CS3000 main window.

2.4 Starting the Software

Follow these steps to run the CS3000 software.

Using Windows:

Step 1. Run Windows.
Step 2. When you are in Windows, select the Drive Control and Configuration program group.
Step 3. Double-click the CS3000 icon within the CS3000 program group.
Using Windows 98:

- From the Start menu, choose Programs and Control and Configuration.

The CS3000 Main Window is displayed as shown in Figure 2.4.

![Sample Main Window for an Established Connection](image)

The CS3000 software tries to establish communication with the drive.

<table>
<thead>
<tr>
<th>If communication is:</th>
<th>Then:</th>
</tr>
</thead>
</table>
| established          | - The drive type (GV3000, Liqui-Flo, or FlexPak 3000) and version is displayed in the Selected Drive field.  
- "UNTITLED" is displayed in the Opened configuration field.  
- Drives that have Vector or Volts/Hertz options display the currently selected option.  
- "Connected" is displayed on the right side of the main window.  
- The configuration on the drive is uploaded to the personal computer.  
- The drive status window is automatically opened. See section 6.2 for more information. |
| not established      | - The Selected Drive field displays either "UNTITLED" or the drive that was selected the last time the CS3000 software was run. If the Selected Drive field displays "UNTITLED," you must select a drive. See chapter 3 for more information.  
- "Disconnected" is displayed on the right side of the main window.  
- "UNTITLED" is displayed in the Opened Configuration field.  
- Drives that have Vector or Volts/Hertz options display the currently selected option. |
If you want to establish communication, but the CS3000 software is not connecting to the drive:

- Make sure power to the drive is on.
- See section 2.3, Setting Up Communication Between the CS3000 Software and the Drive.

## 2.5 About the Menus and Toolbars

Use the menus and toolbar to navigate through the software as described in the following sections.

### 2.5.1 About the Menus

Table 2.1 explains the CS3000 software functions you can access through the menu.

<table>
<thead>
<tr>
<th>Use this menu:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Access and manage configuration files</td>
</tr>
<tr>
<td><strong>Drive</strong></td>
<td>Connect to and disconnect from the drive</td>
</tr>
<tr>
<td></td>
<td>Select a drive</td>
</tr>
<tr>
<td></td>
<td>Control the drive</td>
</tr>
<tr>
<td></td>
<td>View drive status and alarms</td>
</tr>
<tr>
<td></td>
<td>Use the PC Scope</td>
</tr>
<tr>
<td></td>
<td>Set parameters in the drive to the default values</td>
</tr>
<tr>
<td></td>
<td>Save drive parameter values to the drive’s non-volatile memory (for drives that support this option)</td>
</tr>
<tr>
<td></td>
<td>Restore values from the drive’s non-volatile memory to its run-time memory (for drives that support this option)</td>
</tr>
<tr>
<td></td>
<td>Tune GV3000 or Liqui-Flo drives (vector regulation only)</td>
</tr>
<tr>
<td><strong>Config</strong></td>
<td>Edit a configuration file</td>
</tr>
<tr>
<td></td>
<td>Enter a description for a configuration file</td>
</tr>
<tr>
<td></td>
<td>Upload or download a configuration file</td>
</tr>
<tr>
<td></td>
<td>Compare a configuration file</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td>Choose the COM port on the personal computer which is being used to connect to the drive.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Access the online help.</td>
</tr>
</tbody>
</table>
2.5.2 About the Toolbar

A graphical tool bar, displayed below the main menu in the main window, provides a shortcut method for executing commonly-used main menu functions. Figure 2.5 shows the toolbar, and table 2.2 lists the functions represented by each icon.

Figure 2.5 – Graphical Tool Bar
Table 2.2 – Toolbar Icons and Menus

<table>
<thead>
<tr>
<th>To:</th>
<th>Use this icon:</th>
<th>Or this menu command:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new configuration file.</td>
<td></td>
<td>File</td>
</tr>
<tr>
<td>Open a configuration file.</td>
<td></td>
<td>File</td>
</tr>
<tr>
<td>Save a configuration file.</td>
<td></td>
<td>File</td>
</tr>
<tr>
<td>Connect to a drive.</td>
<td></td>
<td>Drive</td>
</tr>
<tr>
<td>Disconnect from a drive.</td>
<td></td>
<td>Drive</td>
</tr>
<tr>
<td>Upload a configuration file from a drive.</td>
<td></td>
<td>Config</td>
</tr>
<tr>
<td>Download a configuration file from a drive.</td>
<td></td>
<td>Config</td>
</tr>
<tr>
<td>Edit a configuration file.</td>
<td></td>
<td>Config</td>
</tr>
<tr>
<td>Add or edit a description for a configuration.</td>
<td></td>
<td>Config</td>
</tr>
<tr>
<td>Monitor drive parameters.</td>
<td></td>
<td>Drive</td>
</tr>
</tbody>
</table>
2.6 Exiting the CS3000 Software

To exit the software, choose Exit from the File menu. Exit closes the CS3000 software. If you modified the open configuration, you are prompted to save the changes to a configuration file.
This chapter describes how to configure a drive.

### 3.1 Selecting a Drive

To create a configuration for a drive while the drive is not connected to the CS3000 software, you must choose a drive type. Communication with the drive is not established, but you can open, save and edit configurations. You can also create Parameter lists using the Parameter Monitor.

For information about establishing communication with a drive, see chapter 8.

To select a drive type, follow these steps:

1. **Step 1.** From the Drive menu, choose Select.

   The Drive Select dialog box is displayed as shown in figure 3.1.

   ![Drive Select - Disconnected](image)

   **Figure 3.1 – Drive Select—Disconnected**

   Step 2. **Select the drive type and software version as well as the model number and any options (if supported by the drive).** Your choice of a model number determines the default values for U.xxx and H.xxx parameters.

   Step 3. **Click OK to select the drive type.**

   If you select a GV3000 (version 5.0 or later) or Liqui-Flo drive, the options box displays the option selections. Selecting RMI results in the \( r \) parameters being listed in the Parameter Monitor and Configuration Editor. You must select the Power Module’s model number as well.

   You can establish communication with the drive by selecting Connect or by re-starting the CS3000 software. See chapter 8 for more information.
3.2 Creating a New Configuration

You can create a new drive configuration, which sets the parameter values to their defaults. You assign a name to the configuration file when you save it. See section 3.6 for information about saving configurations.

To create a new configuration:

- From the File menu, choose New, or click.

If a configuration file is already open and has been changed, a dialog box is displayed that asks if you want to save the current configuration file. If you select Yes, the Save As dialog box is displayed before the new configuration file is opened.

When you create a new GV3000 or Liqui-Flo configuration, the File New dialog box (figure 3.2) is displayed. This lets you select the Vector or Volts/Hertz control (regulation) type and USA, Japan, or Europe as the default type.

After making your selections, select OK to open the new configuration file.

![File New Window](image)

Figure 3.2 – File New Window

When you select the control type, parameters that depend on the control type are changed to their defaults. The control type determines which parameters are displayed. See the appropriate drive instruction manual for more information about the control and default type options.
3.3 Opening a Drive Configuration File

Opening a drive configuration file loads the file from the personal computer to the CS3000 software. Once the configuration file is opened, you can download it to the drive.

To open a configuration file:

Step 1. From the File menu, choose Open or click.

Step 2. If you already have a configuration file open and have made edits to it that have not been saved, you are prompted to save the changes. Make the appropriate selection. See section 3.6 for more information about saving configuration files.

The Open Configuration File dialog box is displayed. An example is shown in figure 3.3.

Step 3. The Open Configuration File dialog box defaults to the work directory of the CS3000 software, which was specified during installation. If this is not the correct directory, select the directory where the file is stored.

Step 4. Select the name of the file you want to open. The name of the file should be copied in the File Name box. If not, click on it again.

If the configuration file you want does not have the .CNF extension, it does not show up automatically in the box under File Name. In this case, select *. in the List Files of Type box to display all of the available files in the File Name list.

Step 5. Open the file by selecting OK. The name of the file you selected now appears in the Opened Configuration field of the main window.

To close the dialog box without selecting a file, select Cancel.
<table>
<thead>
<tr>
<th>If the configuration file was:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>not created for the drive currently selected in the CS3000 software</td>
<td>an error message is displayed and the configuration file is not opened</td>
</tr>
<tr>
<td></td>
<td>Select a configuration file that was created for the selected drive, or change the selected drive. See section 3.1 for information about selecting a drive.</td>
</tr>
<tr>
<td>created for a different version of the currently selected drive</td>
<td>a message box is displayed</td>
</tr>
<tr>
<td></td>
<td>Refer to section 3.4 for more information about opening a configuration file for a different version of the same drive.</td>
</tr>
</tbody>
</table>
3.4 Opening a Configuration File for a Different Version of the Same Drive

Configuration files include version information about the drive. When you open a configuration file, the CS3000 software compares the configuration file’s drive version to the version of the selected drive. If the versions are different, a message box alerts you of the difference.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>not open the file</td>
<td>Choose No.</td>
<td>The software returns to the main window without opening the file.</td>
</tr>
<tr>
<td>to copy the configuration file to the CS3000 software</td>
<td>Choose Yes.</td>
<td>A copy of the original configuration file is created. Then the CS3000 software checks for differences between the parameters in the copy and the parameters in the currently selected drive. If no parameter differences are found, the CS3000 main window is displayed and the opened configuration is named “UNTITLED.” The original configuration file is not changed. To save the new configuration, see section 3.6. If parameter differences are found, the CS3000 software replaces the parameters in the copied configuration to match the parameters of the currently selected drive version. The Configuration Changes dialog box is displayed, which shows you what changes were made. This dialog box cannot be edited.</td>
</tr>
</tbody>
</table>
When parameter differences are found, the CS3000 software makes the following changes to parameters in the configuration file:

<table>
<thead>
<tr>
<th>If the:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>selected drive is a later version than the drive</td>
<td>• Parameters are added if they did not exist in the earlier drive.</td>
</tr>
<tr>
<td>for which the configuration file was created</td>
<td>• These parameters are set to default values.</td>
</tr>
<tr>
<td></td>
<td>• Parameters that existed in the earlier file might be set to</td>
</tr>
<tr>
<td></td>
<td>• defaults if some of the options for the parameter did not</td>
</tr>
<tr>
<td></td>
<td>• exist in the earlier drive version.</td>
</tr>
<tr>
<td>selected drive is an earlier version than the</td>
<td>• Parameters are deleted if they do not exist in the earlier drive.</td>
</tr>
<tr>
<td>configuration file</td>
<td></td>
</tr>
<tr>
<td>parameter range changed between versions of the</td>
<td>• A parameter value that is too high is set to the maximum allowed</td>
</tr>
<tr>
<td>drive and the parameter is set to a value that is</td>
<td>• for the selected drive.</td>
</tr>
<tr>
<td>out of range for the selected drive</td>
<td>• A parameter value that is too low is set to the minimum value</td>
</tr>
<tr>
<td></td>
<td>allowed for the selected drive.</td>
</tr>
</tbody>
</table>

From the Configuration Changes dialog box, you can print the changes, save the changes to a file for reference, or simply review the changes and return to the main window.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>review the changes</td>
<td>Use the scroll bar to view the list</td>
</tr>
<tr>
<td>print the changes</td>
<td>Choose Print.</td>
</tr>
<tr>
<td></td>
<td>The standard Windows Print dialog box is displayed</td>
</tr>
<tr>
<td>save the changes to a file that can be viewed by an</td>
<td>Step 1. Choose Print.</td>
</tr>
<tr>
<td>editor such as Windows Notepad</td>
<td>Step 2. Select the Print to File checkbox.</td>
</tr>
<tr>
<td></td>
<td>Step 3. Choose OK.</td>
</tr>
<tr>
<td></td>
<td>Step 4. Specify a directory, file name, and extension.</td>
</tr>
<tr>
<td></td>
<td>Step 5. Choose OK.</td>
</tr>
<tr>
<td>return to the main window from the Configuration</td>
<td>Choose OK.</td>
</tr>
<tr>
<td>Changes dialog box</td>
<td>When you return to the main window, the opened configuration is</td>
</tr>
<tr>
<td></td>
<td>shown as “UNTITLED.” The original configuration file is not</td>
</tr>
<tr>
<td></td>
<td>changed. To save the new configuration, see section 3.6.</td>
</tr>
</tbody>
</table>
3.5 Editing a Configuration

You can edit the opened configuration using the Configuration Editor. When the editor is started, the software makes a copy of the opened configuration for you to work on. This gives you the option of either saving or ignoring the changes when you exit the Configuration Editor.

To access the Configuration Editor:

- From the Config menu, choose edit, or click.

Figure 3.4 shows a sample Configuration Editor.

![Figure 3.4 – Configuration Editor](image)

The parameters shown in the Configuration Editor are the ones that you can modify and download to the drive or save to a configuration file. Only retentive input parameters appear in the Edit dialog box.

3.5.1 Assigning Parameter Values

Use the Configuration Editor to change parameter values. You can change values by doing one of the following:

- Select the parameter you want to change and choose the Assign button.
- Select the parameter you want to change and edit the parameter directly.
- Double-click on the parameter.
Move between parameter values in the editor by:

- clicking the values themselves
- using the scroll bar
- pressing the [Tab], [PgUp], [PgDn], or arrow keys

When you select Assign or double-click on a parameter, a Parameter Assignment dialog box is displayed. The options in this dialog box depend on the options for the parameter.

<table>
<thead>
<tr>
<th>If the parameter:</th>
<th>The dialog box looks like this:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>can be set to any value within a range</td>
<td><img src="image" alt="Parameter Assignment dialog box" /></td>
<td>Enter the value in the box or change the value by using the scroll bar.</td>
</tr>
<tr>
<td>has limited options</td>
<td><img src="image" alt="Parameter Assignment dialog box" /></td>
<td>Click the arrow and select from the options.</td>
</tr>
<tr>
<td>can be set through the options or by selecting a value within a range</td>
<td><img src="image" alt="Parameter Assignment dialog box" /></td>
<td>Click the arrow and select from the options, or enter the value in the box.</td>
</tr>
</tbody>
</table>
**Important:** If you change a drive’s control type parameter (for example, vector or volts/hertz for GV3000 drives), a message is displayed notifying you that changing the control type will reset parameters to their default values and prompting you to continue. If you select Yes to continue, the parameter list is changed to show only parameters that are relevant for the new control type, and parameters in the Editor are set to defaults. These changes only affect the configuration in the Editor.

Selecting OK in the Parameter Assignment dialog box sets the selected parameter value and exits the dialog box. Cancel ignores any changes and exits the dialog box.

### 3.5.2 Ending an Editing Session

When you have finished editing parameters, select OK from the Configuration Editor to write the values of the edited parameters into the opened configuration. You should then use the Save command from the File menu to save the edited configuration file to disk.

If you select Cancel from the Configuration Editor, a message is displayed prompting you to ignore the changes or accept them. If you ignore the changes, any new parameter values entered during the editing session are ignored, and the session ends.

### 3.5.3 Entering and Editing a Configuration Description

You can add a description to a configuration file that documents information you want to convey about the configuration. The configuration description appears in the main window under the name of the opened configuration and on printouts of the configuration.

To enter or edit a configuration description:

**Step 1.** From the Config menu, choose Description.

The Configuration Description dialog box appears as shown in figure 3.5.

![Figure 3.5 – Configuration Description Dialog Box](image)

- **Step 2.** Type in new text or edit and existing description. See table 3.1 for editing tips.
- **Step 3.** Save your edits and close the dialog box by clicking OK.
3.6 Saving a Drive Configuration

Saving a file writes the open drive configuration to the configuration file that is shown in the main window. This writes over the configuration file shown in the main window.

To save a file:
- From the File menu, choose Save, or click .

If the configuration file is “Untitled,” the Save Configuration File dialog box is displayed. Refer to section 3.7 for more information.
3.7 Saving the Open Drive Configuration to Another File

You can write the open drive configuration to a configuration file other than the one shown in the main window. To do this:

Step 1. From the File menu, choose Save As.

The Save Configuration File dialog box is displayed, as shown in figure 3.7

Step 2. Select the drive and directory where you want to store the configuration. Selecting Network lets you access any mapped network drive.

Step 3. Specify the file name in the File Name field. Configuration file names must be eight alphanumeric characters or fewer. The file name should have the extension .CNF.

Step 4. Select OK to save the file. Select Cancel to close the dialog box without saving.
3.8 Printing a Configuration

You can send a copy of the open configuration to a printer or to a text file. The printout lists the configuration parameters and their assigned values.

To print a configuration:

- From the File menu, choose Print, or click 📜

The standard Windows Print dialog box. The Selection and Pages options are always grayed (non-selectable)

Figures 3.8 shows a sample printout.

---

Drive type: UV3000 V4.0  
Configuration: UNTITLED - V/Hz

<table>
<thead>
<tr>
<th>Pnm</th>
<th>Value</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P001</td>
<td>20.0</td>
<td>Sec</td>
<td>Accel time 1 (RAMP 1)</td>
</tr>
<tr>
<td>P002</td>
<td>20.0</td>
<td>Sec</td>
<td>Decel time 1 (RAMP 1)</td>
</tr>
<tr>
<td>P003</td>
<td>5.0</td>
<td>Hertz</td>
<td>Minimum speed</td>
</tr>
<tr>
<td>P004</td>
<td>60.0</td>
<td>Hertz</td>
<td>Maximum speed</td>
</tr>
<tr>
<td>P005</td>
<td>100</td>
<td>%</td>
<td>Current limit</td>
</tr>
<tr>
<td>P007</td>
<td>0</td>
<td></td>
<td>TB digital inputs config</td>
</tr>
<tr>
<td>P008</td>
<td>Analog</td>
<td></td>
<td>TB speed ref sel</td>
</tr>
<tr>
<td>P009</td>
<td>0</td>
<td></td>
<td>TB analog input offset</td>
</tr>
<tr>
<td>P010</td>
<td>1,000</td>
<td></td>
<td>TB analog input gain</td>
</tr>
<tr>
<td>P011</td>
<td>Off</td>
<td></td>
<td>TB analog input invert</td>
</tr>
<tr>
<td>P012</td>
<td>SpdBl</td>
<td></td>
<td>TB analog output source</td>
</tr>
<tr>
<td>P013</td>
<td>Fault</td>
<td>Output relay config</td>
<td></td>
</tr>
<tr>
<td>P014</td>
<td>None</td>
<td></td>
<td>Trim ref. source select</td>
</tr>
<tr>
<td>P015</td>
<td>0.0</td>
<td>%</td>
<td>Trim gain percentage</td>
</tr>
<tr>
<td>P016</td>
<td>0.0</td>
<td>%</td>
<td>Draw gain percentage</td>
</tr>
<tr>
<td>P017</td>
<td>20.0</td>
<td>Sec</td>
<td>Accel time 2 (RAMP 2)</td>
</tr>
<tr>
<td>P018</td>
<td>20.0</td>
<td>Sec</td>
<td>Decel time 2 (RAMP 2)</td>
</tr>
<tr>
<td>P019</td>
<td>On</td>
<td></td>
<td>S-Curve Enable</td>
</tr>
<tr>
<td>P020</td>
<td>5.0</td>
<td>Hertz</td>
<td>Jog speed reference</td>
</tr>
<tr>
<td>P021</td>
<td>20.0</td>
<td>Sec</td>
<td>Jog ramp accel time</td>
</tr>
<tr>
<td>P022</td>
<td>20.0</td>
<td>Sec</td>
<td>Jog ramp decel time</td>
</tr>
<tr>
<td>P023</td>
<td>20.0</td>
<td>Sec</td>
<td>MOP accel/decel time</td>
</tr>
<tr>
<td>P024</td>
<td>IET</td>
<td></td>
<td>MOP reset configuration</td>
</tr>
<tr>
<td>P025</td>
<td>CCAST</td>
<td>Stop mode</td>
<td></td>
</tr>
<tr>
<td>P026</td>
<td>IET</td>
<td>Func-loss type mode</td>
<td></td>
</tr>
<tr>
<td>P027</td>
<td>Off</td>
<td>Reverse disable</td>
<td></td>
</tr>
<tr>
<td>P028</td>
<td>1800</td>
<td>RPM display scaling</td>
<td></td>
</tr>
<tr>
<td>P029</td>
<td>0</td>
<td>Elapsed time meter</td>
<td></td>
</tr>
<tr>
<td>P030</td>
<td>Off</td>
<td>Reverse disable</td>
<td></td>
</tr>
<tr>
<td>P031</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 1</td>
</tr>
<tr>
<td>P032</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 2</td>
</tr>
<tr>
<td>P033</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 3</td>
</tr>
<tr>
<td>P034</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 4</td>
</tr>
<tr>
<td>P035</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 5</td>
</tr>
<tr>
<td>P036</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 6</td>
</tr>
<tr>
<td>P037</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 7</td>
</tr>
<tr>
<td>P038</td>
<td>5.0</td>
<td>Hertz</td>
<td>Multispeed preset 8</td>
</tr>
<tr>
<td>P039</td>
<td>On</td>
<td>Motor overload</td>
<td></td>
</tr>
<tr>
<td>P040</td>
<td>Off</td>
<td>Motor overload source</td>
<td></td>
</tr>
<tr>
<td>P041</td>
<td>SpdBl</td>
<td>Motor overload type</td>
<td></td>
</tr>
<tr>
<td>P042</td>
<td>5.0</td>
<td>Sec</td>
<td>Line dip rise time</td>
</tr>
<tr>
<td>P043</td>
<td>0</td>
<td>Fault reset counts</td>
<td></td>
</tr>
<tr>
<td>P044</td>
<td>0</td>
<td>Sec</td>
<td>Fault auto reset time</td>
</tr>
<tr>
<td>P045</td>
<td>8</td>
<td>kHz</td>
<td>Carrier frequency (kHz)</td>
</tr>
<tr>
<td>P046</td>
<td>V/HZ</td>
<td>Controller type select</td>
<td></td>
</tr>
<tr>
<td>P047</td>
<td>USA</td>
<td>Country default select</td>
<td></td>
</tr>
<tr>
<td>P048</td>
<td>IET</td>
<td>Option: comm loss select</td>
<td></td>
</tr>
<tr>
<td>P049</td>
<td>0.000</td>
<td>Option: type and version</td>
<td></td>
</tr>
<tr>
<td>P050</td>
<td>0.0</td>
<td>Amps</td>
<td>Power module output amps</td>
</tr>
<tr>
<td>P051</td>
<td>0.00</td>
<td>Software version number</td>
<td></td>
</tr>
<tr>
<td>P052</td>
<td>UnSel</td>
<td>Power module type</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3.8 – Sample Configuration File Printout
This chapter describes how to upload, download, and compare drive configurations.

4.1 Uploading a Drive Configuration

You can upload the drive configuration from the connected drive to the personal computer.

To upload a configuration:

Step 1. Make sure the personal computer is connected to the drive. Refer to sections 2.3 and 3.1 if you need instructions for connecting the personal computer to a drive.

Step 2. From the Config menu, choose Upload or click \( \text{(upload icon)} \).

Step 3. If a drive configuration is already opened, you are prompted to save that configuration to a file. The open configuration (if any) is replaced by the uploaded drive configuration.

After uploading the drive configuration, the open configuration is displayed as “UNTITLED.”
4.2 Downloading a Configuration to the Drive

You can copy the opened configuration currently in the CS3000 software to the connected drive.

**ATTENTION:** The download command replaces the parameter values in the drive with the parameter values from the open configuration. Only qualified personnel should develop and download drive configurations. Read and understand the drive instruction manual in its entirety before downloading a configuration. Failure to observe this precaution could result in severe bodily injury or loss of life.

**Important:** If FlexPak 3000 parameter changes are disabled by the drive’s Program Protection jumper (J16), you cannot write parameters to the drive.

To download an opened configuration to the connected drive, follow these steps:

**Step 1.** Make sure the personal computer is connected to the drive. Refer to sections 2.3 and 3.1 if you need instructions for connecting the personal computer to a drive.

**Step 2.** Make sure the drive is stopped before downloading a configuration to the drive.

**Step 3.** From the Config menu, choose Download, or click 📞 .

**Step 4.** If the downloaded configuration contains parameter values that are out of range for the drive, the software on the drive modifies these parameter values to bring them within allowed ranges. If this occurs, a Download Configuration Changed dialog box is displayed. This dialog box displays the differences between the downloaded configuration and the configuration currently in the drive. The software prompts you to specify if the changes made in the drive should also be made to the configuration in the CS3000 software. To update the opened configuration, select Yes. To not update the configuration, select No.
4.3 Comparing the Drive Configuration to the Opened Configuration

You can compare all of the parameter values in the opened configuration with the parameter values in the drive. For drives with more than one control type (for example, volts/hertz and vector), only parameters that are relevant to the selected control type are compared.

To compare the parameters in an open configuration with those on the drive, follow these steps:

Step 1. Make sure the personal computer is connected to the drive. Refer to sections 2.3 and 3.1 if you need instructions for connecting the personal computer to a drive.

Step 2. From the Config menu, choose Compare Drive.

Parameters with different values are shown in a dialog box. Table 4.1 lists actions you can perform in the Compare dialog box.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit the Compare dialog box</td>
<td>Choose OK.</td>
</tr>
<tr>
<td>Print the list of changes</td>
<td>Choose Print. The standard Windows Print dialog box is displayed.</td>
</tr>
</tbody>
</table>
| Save the list of changes to a file that can be viewed by an editor such as the Windows Notepad | Step 1. Select Print. The standard Windows Print dialog box is displayed.  
Step 2. Select the Print to File checkbox. 
Step 3. Select OK. The Print Differences to File dialog box is displayed. This dialog box is the same as the Save dialog box. 
Step 4. Specify a directory, file name, and extension, and click OK. |
4.4 Comparing the Parameter Values in the Opened Configuration with Those in Another Configuration File

You can compare the parameter values in the opened configuration with those parameter values in another configuration file. To do this:

Step 1. Make sure the configuration file to be compared is opened.

Step 2. From the Config menu, choose Compare File.

The Compare Configuration dialog box is displayed as shown in Figure 4.1.

![Figure 4.1 – Compare Configuration File Dialog Box](image)

Step 3. Use the dialog box to specify the file that you want to compare with the opened configuration file. Use the Network button to access network drives.

Step 4. Begin the comparison by clicking OK.
Parameters with different values are shown in a dialog box similar to the one shown in figure 4.2. Table 4.2 lists actions you can perform in the Configuration Differences dialog box.

![Configuration Differences Dialog Box](image-url)

**Figure 4.2 – Configuration Differences Dialog Box**

**Table 4.2 – Configuration Differences Dialog Box Options**

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit the Compare dialog box</td>
<td>Choose OK.</td>
</tr>
<tr>
<td>Print the list of changes</td>
<td>Choose Print. The standard Windows Print dialog box is displayed.</td>
</tr>
</tbody>
</table>
| Save the list of changes to a file that can be viewed by an editor such as the Windows Notepad | Step 1. Select Print. The standard Windows Print dialog box is displayed.  
Step 2. Select the Print to File checkbox.  
Step 3. Select OK. The Print Differences to File dialog box is displayed. This dialog box is the same as the Save dialog box.  
Step 4. Specify a directory, file name, and extension, and click OK. |
**Important:** The drive tuning functions are available only for GV3000 and Liqui-Flo drives using vector regulation. If you have a GV3000 or Liqui-Flo drive using volts/hertz regulation, or a FlexPak 3000 drive, you cannot use these functions.

The drive tuning functions aid in the setup of drive tuning parameters. You should set up the drive (except the drive tuning parameters) before performing drive tuning. You should also save your drive configuration before tuning the drive. The drive must be connected to the motor to perform some of these functions and the motor nameplate information must be entered correctly.

These functions are selected under Drive|Tuning in the CS3000 main menu. If the drive tuning functions are not supported for the selected drive, the menu item is grayed.

When Drive|Tuning is selected from the CS3000 main menu, the menu appears as follows:

![Drive Tuning Menu](image)

Section 5.1 describes saving the drive configuration. Sections 5.2 and 5.3 describe how to perform Standard tuning and Custom tuning for GV3000 and Liqui-Flo vector drives.
5.1 Saving the Drive Configuration Before Tuning

Some of the tuning tests temporarily modify drive parameters in order to run the test. If the test completes normally, the drive tuning procedure restores the values of these parameters. If power is lost, or if communication between the personal computer and the drive is lost, the original parameter settings in the drive could be lost. Before beginning the Standard tuning or Custom tuning procedures, you are prompted to upload the drive configuration (the same as described in section 4.1) and save it in a file (the same as described in section 3.7). If needed, this saved configuration can be downloaded to the drive to restore its configuration.

5.2 Using Standard Tuning

Standard tuning is designed for applications with normal performance requirements. The tuning process is largely automatic. You will be presented a series of simple dialog boxes or message boxes that explain each step, and will be prompted to verify and accept the system-generated values.

ATTENTION: This equipment is at line voltage when AC power is connected. Disconnect and lockout all ungrounded conductors of the AC power line before working on the unit. Failure to observe this precaution could result in severe bodily injury or loss of life.

When Standard is selected, the Motor Data dialog box will be displayed as shown in figure 5.2. The values displayed are read from the drive.

The steps below appear in the order that the dialog boxes appear.

Important: Before beginning this procedure, make sure that the motor is connected to the drive and, if possible, disconnected from the load.

![Drive Standard Tune: Verify Motor Data dialog box](image-url)

Figure 5.2 – Example of Motor Data Dialog Box
ATTENTION: The setting of parameters U.001 (Encoder PPR), U.002 (Motor Poles), U.003 (Motor Nameplate Base Frequency), U.005 (Motor Nameplate RPM), and U.017 (Motor Top Speed) determines the motor maximum speed. These parameters must be set by a qualified person who understands the significance of setting them accurately. Failure to observe this precaution could result in bodily injury.

Step 1. **Verify Motor Data** - The motor nameplate data parameter values are displayed.
   a. Enter new values as needed. Press Assign to write the values to the drive.
   b. Press Continue when all values are correct.

Step 2. **Measure Magnetizing Current** - A message box with the magnetizing current value is displayed.
   a. Click No to use the displayed value (and skip to step 3) or click Yes to measure the magnetizing current. If measure magnetizing current is selected, the following message is displayed:
      “The load must be uncoupled from the motor shaft to run this test. If the load is not uncoupled, the test results may be incorrect. Select OK when you are ready to run the test or Cancel to quit.”
   b. Lock out and tag all power to the drive and its load.
   c. Disconnect the load from the motor shaft.
   d. Remove the lockout and reapply power to the drive.
   e. Click OK. The following message is displayed:
      “Warning:
      When OK is selected, the motor will accelerate gradually to 90% of base speed. The acceleration and deceleration times will be about 30 seconds. Select OK to begin the test or Cancel to quit.”
   f. Click OK to start the motor, accelerate to 90% of base speed, and measure the magnetizing current.
   g. When the measurement is complete, click OK to continue. (Note that, if the self-tune fails, a message box containing an error message is displayed.)

Step 3. **Calculate Torque and Flux gains** - Torque and flux current gains are calculated (using the magnetizing current value and motor nameplate data) and are displayed.
   Click Yes to write the displayed values to the drive, or click No if you do not want the calculated torque and flux gains written to the drive.

Step 4. **Measure Inertia** - The following message is displayed:
   “The load must be coupled to the motor shaft before running this test. If the load is not coupled, the test results will be incorrect. Select OK when you are ready to begin this test or Cancel to quit.”
   a. Lock out and tag all power to the drive and its load.
   b. Connect the load to the motor.
c. Remove the lockout and reapply power to the drive.

d. Click OK. The following message is displayed:

   “Warning:
   This test will set Current Limit (P.005) to the Magnetizing Current (U.006) plus 20%. The motor will be run at 10% of synchronous speed for several seconds and then step to 95% of synchronous speed. Select OK to begin the test or select Cancel to quit.”

e. Click OK to start the motor and accelerate to 95% of synchronous speed.

f. The drive will run the motor and driven machinery to measure inertia.

g. When the measurement is complete, click OK to continue.

Step 5. **Calculate Speed Loop Gains** - The proportional and integral gains are calculated using default values.

   Click Yes to write the displayed values to the drive (U.012 and U.013), or click No to leave the values in the drive unchanged.

This completes the Standard tuning process.
5.3 Using Custom Tuning

Custom tuning opens a drive tuning dialog box with more advanced tuning features. It is intended for applications requiring a high degree of performance.

**ATTENTION:** This equipment is at line voltage when AC power is connected. Disconnect and lockout all ungrounded conductors of the AC power line before working on the unit. Failure to observe this precaution could result in severe bodily injury or loss of life.

The custom drive tuning dialog box consists of four areas. You can move from area to area by clicking the appropriate radio button. The areas are:

- Motor data
- Torque/Flux
- Speed Loop
- Profile

**Important:** Before beginning this procedure, make sure that the motor is connected to the drive and, if possible, disconnected from the load.

5.3.1 Setting Motor Data

Motor nameplate data can be viewed or changed. When you select Motor Data, the Drive Tuning dialog box is displayed with motor data values read from the drive. Figure 5.3 provides an example of the Motor Data dialog box.

![Custom Drive Tuning dialog box]

**Figure 5.3 – Example of Setting Motor Data Values**
Use the following procedure to set the motor nameplate values.

Step 1. Click a parameter value and enter a new value to change the value of any of the displayed parameters.

Step 2. Click Assign to write the motor data values to the drive.

### 5.3.2 Tuning the Torque/Flux Loop

The torque/flux loop is tuned by using the motor nameplate data, the magnetizing current value in U.006, and calculating the values for U.014, U.015, U.019, and U.020 using the torque response, flux response, and overshoot damping values.

When you select Torque/Flux, the Drive Tuning dialog appears with torque/flux loop data values read from the drive. Figure 5.4 provides an example of the Torque/Flux Loop dialog box.

---

**ATTENTION:** The setting of parameters U.001 (Encoder PPR), U.002 (Motor Poles), U.003 (Motor Nameplate Base Frequency), U.005 (Motor Nameplate RPM), and U.017 (Motor Top Speed) determines the motor maximum speed. These parameters must be set by a qualified person who understands the significance of setting them accurately. Failure to observe this precaution could result in bodily injury.
Use the following procedure to tune the Torque/Flux Loop.

Step 1. If the magnetizing current is known, enter the value for U.006 (Magnetizing Current), or accept the displayed value. Continue to step 2.

or

a. Click Start Self-Tune. The following message is displayed:

“The load must be uncoupled from the motor shaft to run this test. If the load is not uncoupled, the test results may be incorrect. Select OK when you are ready to run the test or Cancel to quit.”

b. Lock out and tag all power to the drive and its load.

c. Disconnect the load from the motor shaft.

d. Remove the lockout and reapply power to the drive.

e. Click OK. The following message is displayed:

“Warning:
When OK is selected, the motor will accelerate gradually to 90% of base speed. The acceleration and deceleration times will be about 30 seconds. Select OK to begin the test or Cancel to quit.”

f. Click OK to start self-tune.

The drive is run with Torque Self-Tune Enabled (U.008) to establish the value for the Magnetizing Current (U.006). The display will indicate that self-tune is in progress and that the drive is running.

If an error occurs, Torque Self-Tune Result (U.009) is read and an appropriate error message is displayed.

Step 2. Enter values for torque response, flux response and overshoot damping, or accept the displayed default values.

Torque response is the torque crossover frequency.

Flux response is the flux crossover frequency.

Overshoot damping is a value from 20 to 100, where 20 is the least amount of damping and yields the greatest overshoot to a step in reference, and 100 is the highest amount of damping and yields the least overshoot.

Step 3. Click Calculate Gains.

If any of these values is out of range, the valid range is displayed and the cursor appears on the field containing the error.

The entered response values, the overshoot damping value, and motor data are used to calculate U.014, U.015, U.019 and U.020.

The values for U.014, U.015, U.019 and U.020 will be displayed.

Step 4. Click Assign to write the torque/flux loop data to the drive.

### 5.3.3 Tuning the Speed Loop

The speed loop is tuned by adjusting the speed loop proportional and integral gains (U.012 and U.013). Speed loop tuning is a function of the inertia and desired bandwidth. The inertia of the motor and connected load can be set manually if known. When you select Speed, the Drive Tuning dialog box appears as shown in figure 5.5.
Use the following procedure to tune the Speed Loop.

Step 1. Enter the inertia value for the motor and load in the Lb-Ft**2 box. Continue to step 2.

or

a. Click Start Self-Tune. The following message is displayed:

“The load must be coupled to the motor shaft before running this test. If the load is not coupled, the test results will be incorrect. Select OK when you are ready to begin this test or Cancel to quit.”

b. Lock out and tag all power to the drive and its load.

c. Connect the load to the motor.

d. Remove the lockout and reapply power to the drive.

e. Click OK. The following message is displayed:

“Warning:
This test will set Current Limit (P.005) to the Magnetizing Current (U.006) plus 20%. The motor will be run at 10% of synchronous speed for several seconds and then step to 95% of synchronous speed. Select OK to begin the test or select Cancel to quit.”

f. Click OK to start the motor and accelerate to 95% of base speed.

g. The drive will run the motor and driven machinery to measure inertia.

h. When the measurement is complete, click OK to continue.
Step 2. Enter the desired speed response and overshoot damping values.

Step 3. Click Calculate Gains. The speed loop proportional gain (U.012) and integral gain (U.013) are calculated from speed response, overshoot damping percentage, inertia, horsepower, rated RPM, and top RPM.

You can also manually modify U.012 and/or U.013 by clicking on either parameter and then entering a new value.

Step 4. Click Assign to write the speed loop data to the drive.

### 5.3.4 Using the Profile Feature To Check Drive Tuning

You can use the speed profile generator to facilitate tuning verification and adjustment of drive tuning. Once started, the speed profile generator will alternate between two speed setpoints. You can specify the speed setpoints, acceleration time, deceleration time, and duration at each setpoint. The speed versus time diagram in the profile dialog box, as shown in figure 5.6, indicates how the six profile variables are applied. After starting the profile, the PC Scope feature can be used to monitor torque and/or speed response to verify or fine-tune the response as desired.

When you select Profile, the Drive Tuning dialog box appears as shown in figure 5.6.

![Custom Drive Tuning](image)

Use the following procedure to check drive tuning.

Step 1. Verify that the load is connected to the motor shaft.

Step 2. Enter values for Speed 1 and 2, Time 1 and 2, Accel and Decel.
Step 3. Click Start Profile. The following message is displayed:

“Profile will run the motor alternating between xxx RPM for x.x sec and xxx RPM for x.x sec. Acceleration time is x.x sec, deceleration time is x.x sec. Select OK to run the motor using this profile, or Cancel to quit.”

Step 4. Click Ok to start the profile.

The drive will cycle between Speed 1 and Speed 2, staying at each speed for the amount of time entered for Time 1 and Time 2. You can monitor results in PC Scope (see chapter 9).

Step 5. Click Stop/Reset to stop the drive and the profile.

Some drive parameters (accel/decel) may be modified automatically in order to run the profile. These values will be saved prior to being modified by this function and the original values will be restored when Stop/Reset is selected.

This completes the Custom tuning process.
CHAPTER 6

Monitoring and Editing Drive Parameters

This chapter describes how to monitor and edit parameters using the Parameter Monitor.

6.1 About the Parameter Monitor

Use the Parameter Monitor to view and edit parameter values in the connected drive. You can also set up monitor lists to store your choices for future use. The Parameter Monitor is not affected by and does not affect the opened configuration.

**Important:** If FlexPak 3000 parameter changes are disabled by the drive’s Program Protection jumper (J16), you cannot write parameters to the drive.

You cannot change parameter values in the opened configuration using the Parameter Monitor. To copy changes made in Monitor into the opened configuration, you must upload the drive configuration from the drive (refer to chapter 4).

To access the Parameter Monitor, follow these steps:

Step 1. From the Drive menu, choose Parameter Monitor, or click 📋. A danger message is displayed.

Step 2. Make sure you understand this message, then select Continue to display the Monitor window.

The first time you access the Parameter Monitor, the window is blank. Use the Add, Remove, Assign, and Save buttons at the top of the window to create a parameter list that can be saved for future use. See the following sections for information about using these functions.

When parameters are displayed in the Parameter Monitor window, the parameter values are updated periodically from the drive.
You can select a parameter shown in the Monitor window by clicking the parameter name, or by using PgUp, PgDn, and the arrow keys. The Remove and Assign functions work on the selected parameter. Figure 6.1 shows an example of the Parameter Monitor window.

The sections that follow describe the functions available when using the CS3000 Parameter Monitor function.
6.2 Adding Parameters to the Monitor List

You can add up to twenty parameters to the Monitor List. When you select Add, the Add Parameters to Monitor List dialog box is displayed. The Sort By options let you display the parameters by parameter number or by description (alphabetically). Figure 6.2 shows a sample Add Parameters to Monitor List dialog box.

To add parameters, follow these steps:

Step 1. Use the scroll bar or the arrow keys to move up and down the list of parameters.

Step 2. Use the mouse or the spacebar to select the parameters you want to monitor. You can select multiple parameters before choosing Add. You can select a total of 20 parameters.

Step 3. Do one of the following:

- To add the parameters to the monitor list and continue to display the dialog box, select Add.
- To add the parameters and return to the monitor window, select OK.

6.3 Removing Parameters from the Monitor List

To delete parameters from the Monitor List, follow these steps:

Step 1. Select the parameter you want to remove from the list.

Step 2. Click on the Remove button.

The selected parameter is deleted from the Monitor List. Also refer to section 6.7 for information about the Clear command, which clears multiple parameters from the Monitor List.
6.4 Assigning Values to Parameters on the Drive

The Assign button assigns a value to the selected parameter. The assigned value is displayed on the Parameter List screen and can be sent to the drive.

Important: The Assign function is available only when you are connected to a drive. You cannot assign parameter values unless you are connected to a drive. If you are not connected to a drive, the parameter list displays “???” for all parameter values.

When the drive is running, new values can be assigned only to tunable parameters. For configurable parameters, the drive must be stopped before new values can be assigned. Refer to the appropriate drive instruction manual to determine which parameters are tunable.

When you select Assign or double-click on the parameters, a Parameter Assignment dialog box is displayed. The options in this dialog box depend on the options for the parameter.
If you change the control type parameter on drives that have control types (for example, vector or volts/hertz for GV3000 drives), a message is displayed that reminds you that changing the control type resets the parameters to their default values. The software prompts you to continue. If you select Yes to continue, then:

- The drive is reset.
- The monitor list is changed so that only parameters for that control type are displayed.
- All parameters are set to default value.

<table>
<thead>
<tr>
<th>If the parameter:</th>
<th>The dialog box looks like this:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>can be set to any value within a range</td>
<td><img src="image" alt="Parameter Assignment" /></td>
<td>Enter the value in the box or change the value by using the scroll bar.</td>
</tr>
<tr>
<td>has limited options</td>
<td><img src="image" alt="Parameter Assignment" /></td>
<td>Click the arrow and select from the options.</td>
</tr>
<tr>
<td>be set through the options or by selecting a value within a range</td>
<td><img src="image" alt="Parameter Assignment" /></td>
<td>Click the arrow and select from the options, or enter the value in the box.</td>
</tr>
</tbody>
</table>
To send the new parameter value to the drive, choose the Send button. Send does not exit the parameter Assignment dialog box, so you can continue to make adjustments to the value of the selected parameter and monitor the effect on the drive.

When you have finished making adjustments to the value of a parameter, select OK to send the parameter value to the drive and exit the Parameter Assign dialog box.

If you select Cancel, the parameter value that appears in the Parameter Assign dialog box is ignored and the Parameter Assign dialog box is closed.

6.5 Saving a Monitor List

The Save command creates a file containing the list of parameter numbers you have displayed in the parameter monitor. When you select Save, the Save Monitor List dialog box is displayed as shown in figure 6.3.

To save a monitor list file, follow these steps:

Step 1. Select the drive and directory for the monitor list file.

Step 2. Enter a file name. Monitor list file names must be eight alphanumeric characters or fewer. The file name should include the extension .MON.

Step 3. Save the monitor list by selecting OK, or select Cancel to exit the dialog box without saving.

![Figure 6.3 – Save Monitor List Dialog Box](image_url)
6.6 Displaying a Monitor List

To display a previously-saved monitor list in the CS3000 Parameter Monitor screen, use the Recall button. The monitor list file must have been created and saved. Any parameters currently being displayed in the Parameter Monitor are replaced by the list of parameters read in from the monitor list file. Figure 6.4 shows the Recall Monitor List dialog box.

Use the following steps to read and display a Monitor List file:

Step 1. Select the drive and directory path that contains the monitor list files.

Step 2. If the monitor list files were saved using a file extension other than .MON, select *.* in the List Files of Type box to display all of the files.

Step 3. Enter a file name, or select the file name from the displayed list.

Step 4. To recall the file and display it in the Parameter Monitor window, select OK. To close the dialog box without recalling the monitor list file, select Cancel.
6.7 Clearing the Monitor List Display

Use the Clear button on the Parameter Monitor to remove selected parameters or all parameters from the monitor list display. This command only clears the parameters shown in the monitor list; it does not remove them from the saved monitor list files.

To remove only parameters you select, follow these steps:

Step 1. Select Clear to display the Remove Parameters from Monitor List dialog box.

![Figure 6.5 – Remove Parameters from Monitor List Dialog Box](image)

- Step 2. Select the parameters you want to delete by using the mouse or the space bar. Use the scroll bar, the arrow keys, and the page up and page down keys to move through the list.

- Step 3. Select Remove Selected to remove the parameters without exiting the dialog box.

- Step 4. If you want to remove more parameters, repeat this procedure. If you are done removing parameters, select OK to return to the monitor list.

To remove all of the parameters, select Remove All. All of the parameters are removed and you are returned to the monitor list.

6.8 Exiting the CS3000 Parameter Monitor

To exit the monitor list and return to the CS3000 main window, choose the Close command from the CS3000 Parameter Monitor window. If a parameter list is displayed in Parameter Monitor and it has not been saved to a file, you are prompted to save the list. See section 6.5 for information about saving monitor list files.
CHAPTER 7

Monitoring Drive Status and Alarms

This section describes how to monitor drive status indicators and alarms.

7.1 Displaying and Clearing the Fault Log and Alarm Log

You can display fault or alarm logs to help you troubleshoot problems.

To upload the fault log or alarm log from the drive, follow these steps:

Step 1. Make sure the personal computer is connected to the drive. Refer to chapters 2 and 3 for instructions about connecting the personal computer to a drive.

Step 2. From the Drive menu, choose Fault/alarm, or click 

The fault or alarm number, description, and time stamp is displayed in the list box. The displayed log is updated about once a second with any new alarm or fault information. Figure 7.1 shows a sample fault log while figure 7.2 shows a sample alarm log.

![Fault/Alarm Log](image)

Figure 7.1 – Sample Fault Log List Box
To switch between the fault and alarm list boxes, select the appropriate option for Log Select. If the drive does not support an alarm log, the alarm log option is grayed and is not selectable.

The time stamp displays the time when the fault or alarm occurred. This time is from the drive memory. See the drive instruction manual for information about the time stamp.

To change the time from a time stamp to a calculated time and date, select the Calculated time option. The software uses the drive’s elapsed timer and the PC’s clock to calculate the time that the fault occurred.

**Important:** The calculated time will be incorrect if the drive was powered down or if the elapsed timer was reset since the fault occurred. This is because the fault log information is saved if the drive’s power has been turned off.
Table 6.1 describes how you can use the logs.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>print the displayed log</td>
<td>Select Print. The standard Windows Print dialog box is displayed.</td>
</tr>
</tbody>
</table>
| save the list of faults or alarms to a file that can be viewed by an editor such as Windows Notepad | Step 1. Select Print. The standard Windows Print dialog box is displayed.  
Step 2. Select the Print to File checkbox.  
Step 3. Select OK. The Print Fault [or Alarm] Log to File dialog box is displayed. This dialog box is the same as the Save dialog box. Specify a directory, file name, and extension. |
| clear the fault or alarm log | Select Clear. The logged faults or alarms are deleted from the log. This command clears only the log that is currently displayed. Clear does not reset drive faults or eliminate the cause of the alarms; it simply clears the log. |
| reset the drive after a fault | Select Stop/Reset in the Drive Control window.  
A reset command will be sent to the drive. This command will not be available if the CS3000 software is not the control source. |
| exit the log window         | Select Close.                                                    |
7.2 Monitoring Drive Status

The Drive Status window, shown in figure 7.3, automatically opens when you connect to a drive. The other functions in the CS3000 software are still accessible while this window is open. You can move this window, close it, or leave it displayed. If you close this window while connected to the drive, it can be re-opened by using the Status command from the Drive menu. If you disconnect from the drive, this window is closed.

Figure 7.3 – Drive Status Window
The indicators in the Drive Status window operate as follows:

Table 7.2 – Drive Status Indicators

<table>
<thead>
<tr>
<th>Indicator:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault</td>
<td>Highlighted when the drive is reporting that a fault exists. Otherwise, the indicator is grayed and displays “No Faults.”</td>
</tr>
<tr>
<td>Alarm</td>
<td>Highlighted when the drive is reporting an alarm. Otherwise, the indicator is grayed and displays “No Alarms.”</td>
</tr>
<tr>
<td>Log Full</td>
<td>Highlighted when the fault log is full. When this occurs, faults are no longer added to the log.</td>
</tr>
<tr>
<td>Running/Jogging/Stopped</td>
<td>Shows the appropriate text.</td>
</tr>
<tr>
<td>Drive ready/Drive not ready</td>
<td>Shows the appropriate text.</td>
</tr>
<tr>
<td>Auto/Manual</td>
<td>Displays the reference mode.</td>
</tr>
<tr>
<td>Forward/Reverse</td>
<td>Displays the drive direction if this information is available from the drive.</td>
</tr>
<tr>
<td>Speed Reg/Torque Reg</td>
<td>Displays the regulation type, if applicable.</td>
</tr>
<tr>
<td>Current Limit</td>
<td>Highlighted when the drive is in current limit. The update rate is about 1 second.</td>
</tr>
<tr>
<td>Connected/Disconnected</td>
<td>Shows whether or not the CS3000 software is communicating with a drive. If the software does not receive a response from the drive, the status indicators are grayed and the Connected/Disconnected indicator displays “Disconnected.”</td>
</tr>
</tbody>
</table>

7.3 Restoring Default Values to Drive Parameters

You can restore the default values to all of the drive parameters that have defaults. To do this:

- From the Drive menu, choose Restore defaults.

If the drive does not support this command, this menu item is grayed and is not selectable.

7.4 Saving Drive Parameter Values to Non-Volatile Memory on the Drive

You can save the values of the drive parameters in the drive’s runtime memory to non-volatile memory on the drive. To do this:

- From the Drive menu, choose Memory save.

If the drive does not support this command, this menu item is grayed and is not selectable.
7.5  Restoring Drive Parameter Values from Non-Volatile Memory in the Drive

You can write the values stored by the Memory save command from non-volatile memory on the drive into the drive’s runtime memory. To do this:

- From the Drive menu, choose Memory restore.

If the selected drive does not support this command, then this menu item is not selectable.
This section describes how to control the drive using the CS3000 software.

8.1 Connecting a Drive

You must establish communication with the drive that is connected to the personal computer. When the CS3000 software is successfully connected to the drive, all of the CS3000 menu items supported for the drive are available. The CS3000 software attempts to connect to the drive when the software first starts up. If you cannot connect to the drive, see chapter 3.

To establish communication with the drive, follow these steps:

Step 1. From the Drive menu, choose Connect, or click .

Step 2. If you have a configuration file opened, the software prompts you to save that configuration. Choose Yes or No.

If the CS3000 software does not support the drive, a message box prompts you to continue. If you continue, some parameters in the drive may not be supported by the CS3000 software. The software reports these parameters in the Unknown Parameters dialog box. The unknown parameters can only be used in the Parameter Monitor.

The CS3000 software connects to the drive and automatically:

• reads the drive type and version number from the drive
• makes sure it supports the drive
• uploads parameter information from the drive

The software is now communicating with the drive and can use all of the options in the Drive menu.

8.2 Disconnecting a Drive

You can stop communication between the software and the drive by disconnecting the drive. Except for Connect, Select, and Parameter Monitor, the commands in the Drive menu are not available when the CS3000 software is not connected to the drive.

To stop communication with the drive:

Step 1. From the Drive menu, choose Disconnect or click .

Step 2. Select the drive version number you want to disconnect.

Step 3. Choose OK.
The main window shows “Disconnected.” The CS3000 software cannot communicate with the drive until it is reconnected by using the Connect option or by restarting the CS3000 software.

### 8.3 Controlling a Drive

**ATTENTION:** Only qualified electrical personnel familiar with the construction and operation of the equipment and the hazards involved should adjust or operate this equipment. Failure to observe this precaution could result in severe bodily injury or loss of life.

**Important:** This function is available only for GV3000 drives version 5.0 (and later) and FlexPak 3000 drives version 3.1 (and later). If you are using an earlier version of these drives, the CS3000 software cannot be used to control the drive.

By using the Drive Control dialog box, you can control the Liqui-Flo drive, GV3000 drive (version 5.0 and later) or FlexPak 3000 drive (version 3.1 and later) by:

- selecting the control source, reference mode, and motor rotation direction
- setting the drive reference
- starting and stopping the drive
- monitoring the drive indicators

To access the Drive Control dialog box, follow these steps:

**Step 1.** Make sure the personal computer is connected to the drive. Refer to section 7.1 for information about establishing communication with the drive.

**Step 2.** From the Drive menu, choose Control or click .

A danger message is displayed.

**Step 3.** Make sure you understand this message, then select OK to display the Drive Control window. Figure 8.1 shows an example of a Drive Control window.
You can also access other CS3000 software functions while the Drive Control window is on the screen. The Drive Control window remains open until you close the window (by selecting the Close button) or exit the CS3000 software.

The following sections describe how to use the Drive Control window to control a drive’s functions.

**Important:** If a running drive that is being controlled by the CS3000 software loses communication with the software, a serial fault occurs and the drive stops. If the running drive is being controlled by its front-panel and communication with the software is lost, the message “Disconnected” appears in the main window, and the drive status window displays “Not Connected.”
8.4 Selecting the Control Source

The following note applies to GV3000 and Liqui-Flo AC drives only.

ATTENTION: When parameter P.055 is set to ON, the STOP/RESET key is functional only from the selected control source. As a safety precaution, Reliance Electric recommends that an emergency stop push button be located near the drive in an easily accessible location. As a further safety precaution, the user should post a warning on the drive to alert personnel that the STOP/RESET key is not functional. Failure to observe this precaution could result in severe bodily injury or loss of life.

You can select one of the following as the control source for the drive:

- Local
- Terminal Strip
- Serial
- Network

You must select Serial to control the drive by using the Drive Control window. If any other control source is selected, you can only monitor the drive functions displayed in the Drive Metering window and stop the drive by using Stop/Reset; all of the other drive commands on the Drive Control screen are disabled.

8.5 Selecting the Reference Mode (Auto/Manual)

The Reference Mode control is active only if the control source is set to Serial (CS3000 software control). Use the Auto/Man button to switch the drive reference mode for the connected drive between auto mode and manual mode.

<table>
<thead>
<tr>
<th>To use references from the:</th>
<th>Choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Reference dialog box within the Drive Control window</td>
<td>Manual mode</td>
</tr>
<tr>
<td>selected terminal strip source</td>
<td>Auto mode</td>
</tr>
</tbody>
</table>

8.6 Selecting the Direction of Motor Rotation

The direction control is active only if the control source is set to Serial (CS3000 software control). The Fwd/Rev button toggles between Forward and Reverse. When you make a selection, the appropriate command (forward or reverse) is sent to the drive.

8.7 Setting the Drive Reference

The Manual Reference group box lets you set the drive reference.
Set the drive reference by:

- moving the scroll bar to change the reference value and automatically send the value to the drive, or
- entering a new value in the edit box and selecting the Set button to send the reference value to the drive

### 8.8 Setting the Jog Reference

The Jog reference box lets you set the jog reference. The valid values are the same as for the manual reference. To do this:

1. Click in the Jog reference box and type a new value.
2. Press the Jog Set button.

### 8.9 Starting and Stopping the Drive

The following note applies to GV3000 and Liqui-Flo AC drives only.

**ATTENTION:** When parameter P.055 is set to ON, the STOP/RESET key is functional only from the selected control source. As a safety precaution, Reliance Electric recommends that an emergency stop push button be located near the drive in an easily accessible location. As a further safety precaution, the user should post a warning on the drive to alert personnel that the STOP/RESET key is not functional. Failure to observe this precaution could result in severe bodily injury or loss of life.

Use the Run, Jog, and Stop/Reset buttons as follows:

<table>
<thead>
<tr>
<th>To send this command to the drive:</th>
<th>Press:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>start [Run]</td>
<td></td>
<td>This control is disabled if the CS3000 software is not the control source.</td>
</tr>
<tr>
<td>jog [Jog] (Releasing the button sends the stop command.)</td>
<td></td>
<td>(Note that buttons in Windows dialog boxes normally cause an action when the button is released). This control is disabled if the CS3000 software is not the control source.</td>
</tr>
<tr>
<td>step [Stop/Reset]</td>
<td></td>
<td>— FlexPak 3000 - This control is always enabled, regardless of the control source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— GV3000 or Liqui-Flo - This control can be disabled using parameter P.055. See the software reference manual for more information.</td>
</tr>
</tbody>
</table>

**ATTENTION:** If the CS3000 software is the control source, a fault/alarm reset is performed.
8.10 Monitoring Drive Indicators

The Drive Metering box displays six drive indicators for GV3000 or Liqui-Flo drives or five drive indicators for FlexPak 3000 drives. The items displayed in the Drive Metering box are dependent on drive type and regulation type.

<table>
<thead>
<tr>
<th>For:</th>
<th>The following indicators are listed:</th>
</tr>
</thead>
</table>
| GV3000 or Liqui-Flo drives configured for vector regulation | • Selected reference  
• Motor speed  
• Motor current  
• Motor voltage  
• Motor torque  
• Output power |
| GV3000 or Liqui-Flo drives configured for volts/hertz regulation | • Selected reference  
• Output speed  
• Output frequency  
• Motor voltage  
• Motor current  
• Output power |
| FlexPak 3000 drives               | • Selected reference  
• Motor speed  
• Armature volts  
• Motor current  
• Percent load |

Each drive metering value is displayed as a visual thermometer-type indicator and as a numeric value. If the numeric value exceeds the range of the indicator, the indicator moves slightly beyond the far right line in the indicator grid. The units (RPM, Amps, etc.) shown in figure 8.1 are examples only. The actual units are defined by the drive type are preset.
This section describes how to use the PC Scope.

9.1 About PC Scope

Use PC Scope to plot drive signals. PC Scope displays the plotted values as a trace. The type of signals you can acquire depends upon the drive you have connected.

With PC Scope, you can:

- acquire traces of up to two signals at a time
- capture a trace and save it as a snapshot, which you can then compare to a newly acquired trace
- define a trigger for the traces and specify how much data is gathered and displayed before the trigger condition
- define a data sampling rate and the number of samples to capture for a given trace
- define a color for each to help you discern traces and trace snapshots

Figure 9.1 shows the PC Scope screen. The screen has its own toolbar and status window. Table 9.1 explains the PC Scope toolbar buttons.
Figure 9.1 – The PC Scope Screen
<table>
<thead>
<tr>
<th>To:</th>
<th>Use this button:</th>
<th>Or this menu command:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clears the trace setup, display, and data.</td>
<td>![Folder]</td>
<td>File</td>
</tr>
<tr>
<td>Open a saved trace file.</td>
<td>![Document]</td>
<td>File</td>
</tr>
<tr>
<td>Save the currently displayed trace data, set up, and the snapshots as a trace or ASCII file.</td>
<td>![Folder]</td>
<td>File</td>
</tr>
<tr>
<td>Open the Trace Signal Setup dialog box.</td>
<td>![Tool]</td>
<td>Trace</td>
</tr>
<tr>
<td>Zoom the trace display to the area bounded by the cursors.</td>
<td>![Zoom]</td>
<td>View</td>
</tr>
<tr>
<td>Redisplay the trace in the normal view.</td>
<td>![X1]</td>
<td>View</td>
</tr>
<tr>
<td>Turn cursors on or off.</td>
<td>![Cursors]</td>
<td>View</td>
</tr>
<tr>
<td>Turn cursor tracking on or off.</td>
<td>![Cursor]</td>
<td>Cursor</td>
</tr>
<tr>
<td>Access the online help.</td>
<td>![Help]</td>
<td>Help</td>
</tr>
</tbody>
</table>
To begin using PC Scope, follow these steps:

Step 1. Set up the trace by clicking [ ] and defining the trace information. (See section 9.2 for more information.)
Step 2. Choose how to acquire the trace data. (See section 9.3 for more information.)

9.2 Setting Up a Trace

Before you can acquire any trace data, you must set up the trace by:

- specifying the signals for the trace(s) (See section 9.2.1.)
- setting up data sampling (See section 9.2.2.)
- setting up the trigger (See section 9.2.3.)

Set up a trace by using the Trace Signal Setup dialog box. To access this dialog box:

- From the Trace menu, choose Setup or click [ ].

Figure 9.2 shows the Trace Signal Setup dialog box.

![Trace Signal Setup Dialog Box](image)

Figure 9.2 – Trace Signal Setup Dialog Box
9.2.1 Specifying Signals

Use the Traces group box in the Trace Signal Setup dialog box to specify the signal for each trace.

To specify a signal, follow these steps:

Step 1. Select the drive signal whose values you want to plot as a trace. The available signals are determined by the type of drive that is connected.
   • Choose the signal or None to be used for Trace A by using the Channel A list box.
   • Choose the signal or None to be used for Trace B by using the Channel B list box.

Step 2. Choose the type of scale you want to use for each trace.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use rounded units per division values based on the data in the trace waveform</td>
<td>Select the Auto Scale option for the trace you are defining.</td>
</tr>
<tr>
<td></td>
<td>The difference between the minimum and maximum values in the trace data is determined from the waveform data, and the values are rounded up to the next whole value. For example, a value of 1.763 is rounded to 2.</td>
</tr>
<tr>
<td></td>
<td>The minimum and maximum values are also set to values beyond the actual values in the trace waveform data.</td>
</tr>
<tr>
<td>Specify actual trace vertical axis minimum and maximum values</td>
<td>Enter the vertical axis minimum and maximum values in the Min and Max boxes for the trace you are defining.</td>
</tr>
<tr>
<td>Use the scale for Trace A as the scale for Trace B</td>
<td>Select the option: Use chan A scale.</td>
</tr>
</tbody>
</table>

9.2.2 Setting Up Data Sampling

Use the Data sampling group box in the Trace Setup dialog box to define how the signal data is to be sampled. The settings apply to both traces. To set up data sampling, follow these steps:

Step 1. Choose how often you want to acquire signal data by choosing a sampling rate. Choose from 0.5 ms to 10 s.

Step 2. Choose the number of data samples in the trace. Choose a value from 1000 to 100.

Once you select the sample rate and number of samples, the amount of time for the acquisition is displayed.
9.2.3 Setting Up the Trigger

Use the Trigger and Trigger delay/position group boxes in the Trace Signal Setup dialog box to define a trigger that will begin a data acquisition. You do not need to set up a trigger if you plan to use Auto or Manual to acquire traces. See section 8.3 for more information.

To set up trigger, follow these steps:

Step 1. Choose a drive signal you want to use as a trigger from the Signal list box.

Step 2. Choose the trigger operation (if desired) that causes the trigger condition by using the Operation list box. The available trigger operations are determined by the drive type. Some examples of trigger operations are: less than, greater than, and equal to.

Step 3. Choose a trigger level that is to be used by the trigger operation. The units and normalization depend upon the trigger signal.

Step 4. Choose a trigger position or delay by selecting the appropriate option and entering a value.

<table>
<thead>
<tr>
<th>To:</th>
<th>Choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify how many samples are displayed in the trace before and after the trigger</td>
<td>Position</td>
</tr>
<tr>
<td>For a trigger position of zero percent, the trigger is at the beginning of the trace (all samples displayed were acquired after the trigger). For a trigger position of 100%, the trigger is at the end of the trace, a position of 50% is in the center, etc.</td>
<td></td>
</tr>
</tbody>
</table>

| specify the amount of time between the trigger and the beginning of data acquisition. The delay is measured in seconds. | Delay  |
9.3 Acquiring a Trace

Once you set up a trace, you must define how the trace is to be acquired. A trace can be acquired:

- continuously, regardless of a trigger condition
- continuously or once, as specified by a defined trigger

Use the Trace menu or the radio buttons in the toolbar to define how a trace is to be acquired.

<table>
<thead>
<tr>
<th>To:</th>
<th>From the Trace menu, choose this option, or click on this radio button:</th>
</tr>
</thead>
</table>
| continuously acquire trace data by sending a manual trigger  
The trigger setup has no effect on the trace acquisition. | Auto |
| acquire trace data by sending a manual trigger to the drive  
The trigger setup has no effect on the trace acquisition. | Manual |
| continuously acquire trace data based on the trigger setup  
After the trace is uploaded and displayed, the trace acquisition is re-enabled, and the cycle starts over.  
Trace data is acquired until you change the trace acquisition selection. | Normal |
| acquire a trace based on the trigger setup  
The trace data is acquired when the trigger condition has been reached. | Single |
| stop a trace acquisition in progress  
If an acquisition is not in progress, the trace display is frozen as it is. | Hold |

Figure 9.3 illustrates an acquired trace.
9.4 Working with the Cursors

Cursors help you read the value at a specific point on a trace waveform to help you tune and troubleshoot the drive. PC Scope has two cursor types:

- Y cursors are positioned on a vertical value on the display
- T cursors are positioned on a horizontal or time value

You can read actual data points where the waveform crosses the T cursors. These values are labeled as @T1 and @T2. Because these are actual data points, you can use them for calculations. The Y cursor values are based on the scale of the trace display, so the value is determined by the display resolution and are not as accurate as the actual data points displayed as the @T1 and @T2 values.
### 9.4.1 Moving a Cursor

You can select a cursor by:
- clicking on the cursor label with the mouse
- using the Cursor menu
- using the [Tab] key

Move the cursors by:
- using the up, down, right, and left arrow keys or Shift + arrow key
- clicking on the label with the mouse and dragging the cursor

### 9.4.2 Specifying the Cursors To Track Each Other

You set the cursors to track together when you move them. This way the cursors can move left and right and up and down while maintaining the same distance between T1 and T2 or Y1 and Y2.

To set the T and Y cursors so they track together:
- From the Cursor menu, choose Track or click .

Turning track off lets you move the T cursors independently from each other and the Y cursors independently from each other. Cursor tracking can be turned on and off by toggling the menu selection or toolbar button.

### 9.5 Changing Views

You can turn the cursors on and off and magnify the trace display as described in the following sections.

#### 9.5.1 Turning Cursors On and Off

You can choose to show or not the show the cursors on the trace display.

To turn cursors on or off:
- From the View menu, choose Cursors or click .

You cannot use the Zoom feature if the cursors are off.
9.5.2 Magnifying the Trace Display

You can magnify the area of the trace display that is bounded by the cursors.

To magnify the display:

- From the View menu, choose Zoom In or click 

To return the display back to the normal view:

- From the View menu, choose Zoom X1 or click 

If you selected the Auto Scale option in the Trace Setup dialog box the PC Scope scales ten vertical axis to even values. This may result in no change when you zoom into the trace.

9.6 Taking a Trace Snapshot

You can compare one trace with another by saving trace data and displaying it as a background for the next trace. This saved trace data is called a snapshot. You can take a snapshot of either trace A or B or both. Also, you can choose a color to use for displaying trace snapshots (see section 9.6.2).

9.6.1 Taking a Snapshot

To save a trace and have it displayed as the background for subsequent traces, do the following:

<table>
<thead>
<tr>
<th>To:</th>
<th>From the Snapshot menu, choose:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>save the current Trace A as a snapshot</td>
<td>Trace A</td>
<td>This trace appears as the background for the next Trace A.</td>
</tr>
<tr>
<td>save the current Trace B as a snapshot</td>
<td>Trace B</td>
<td>This trace appears as the background for the next Trace B.</td>
</tr>
<tr>
<td>save both Trace A and Trace B as snapshots</td>
<td>Trace A &amp; B</td>
<td>The traces appear in the background for the next traces.</td>
</tr>
<tr>
<td>clear the snapshots</td>
<td>Clear</td>
<td>The snapshot traces are removed from the background.</td>
</tr>
</tbody>
</table>
9.6.2 Choosing the Trace Snapshot Colors

You can choose the color that is used to display the snapshots of Trace A or Trace B. Keep in mind that the trace display window is displayed using the Windows menu background color, so be careful not to display trace snapshots in the same color, or the trace will not show up.

To choose a color for a trace snapshot, follow these steps:

Step 1. From the Options menu, choose SnapA Color or SnapB Color.

   The color selection dialog box is displayed.

Step 2. Select a standard color or create a custom color and click OK.

Traces can be displayed only in solid colors. If you choose a mixed color, the nearest solid color is used.

9.7 Saving a Trace File

You can save a trace as either a trace file (.TRC) or an ASCII file (.TRA). Saving a trace as an ASCII file lets you import the data into another program such as a spreadsheet program.

Use the Save As command to save the file with a new name. To save a trace file, follow these steps:

Step 1. From the File menu, choose Save or Save As.

   The Save a Signal Trace File dialog box is displayed.

   ![Save Signal Trace File Dialog Box](image)

   Figure 9.4 – Save a Signal Trace File Dialog Box

Step 2. In the file name field, type the name for the file.
Step 3. From the Save file as type list box, choose whether you want to save the file as a Trace file (.TRC) or as an ASCII file (.TRA).

Step 4. From the Drives list box, specify the location where you want to save the file.

Step 5. Click OK to save the file.

9.8 Clearing the Trace Display and Setup

You can clear the trace display and setup. To do this:

- From the File menu, choose New or click .

Creating a new trace file deletes any acquired trace data and clears the trace display.

9.9 Opening a Trace File

You can open a previously saved trace file. To do this, follow these steps:

Step 1. From the File menu, select Open or click .

If you already have a configuration file open and made edits to it that have not been saved, the software prompts you to save the changes. Make the appropriate selection. See section 8.7 for more information about saving configuration files.

The Open Signal Trace File dialog box is displayed. An example is shown in figure 9.5.

![Open Signal Trace File Dialog Box](image)

Figure 9.5 – Open Signal Trace File Dialog Box

Step 2. The Open Signal Trace File dialog box defaults to the working directory of the CS3000 software, which was specified during installation. If this is not the correct directory, select the directory where the file is stored.
Step 3. Select the name of the file you want to open by double-clicking on it with the mouse. The name of the file should be copied in the File Name box. If not, click on it again.

Step 4. Select OK to open the file. To close the dialog box without selecting a file, select Cancel.

The trace file is opened.

9.10 Closing PC Scope

Close PC Scope by choosing Close from the File menu.
This section describes basic troubleshooting information.

10.1 Using Error Messages

An error message might be displayed on the screen while you are using the CS3000 software. In most cases, you should be able to correct the error condition by following the course of action described by the error message. However, if the error message is preceded by an error number, in the format: Error <number> <description>, this indicates an error that might require assistance to correct. In this case, write down the error and the error number, and contact Reliance Electric.

See Appendix A for a list of error messages and their causes.

10.2 Getting Assistance from Reliance Electric

If you have any questions or problems with the products described in this instruction manual, contact your local Reliance Electric sales office.

For technical assistance, call 1-800-726-8112.
Error Messages

**General Error or Error <number> <description>**
If you receive a numbered error, record the error number and any message that is displayed, and call Reliance Electric for assistance.

**Out of memory error. Close other applications to free memory.**
This error is displayed if the software cannot allocate RAM. If it is displayed, you should close other programs or add memory to the computer.

**Out of Disk Space.**
This error occurs if you attempt a print to file or save a configuration to a disk that has insufficient space.

**Missing or unreadable files. Reinstall CS3000.**
At start-up or when a drive is selected, the CS3000 software reads information from data files. This error is displayed if these files have been altered or are not located in the directory containing the CS3000 software.

**Error. Check printer.**
An error occurred while trying to use the printer.

**Error. Could not create timer. Close other applications to free a timer.**
Windows has a limited number of timers. The CS3000 software requires a timer if it is connected to a drive. This message is displayed if no timers are available.

**File Open Error. Check Disk.**
This error can occur if there is a disk problem.

**File read error. Check disk.**
This error can occur if the CS3000 software could not read a file.

**File write error. Check disk.**
This error can occur while writing to a file.

**Cannot read file. File has been corrupted.**
This message indicates that a configuration file has been altered and that the CRC value stored in the file is no longer valid.

**Drive data file format error. Reinstall CS3000.**
This message indicates the drive data file format is incorrect or the file has one or more unknown record types. This indicates that the CS3000 software is incorrectly installed.

**The configuration file drive type is different from the selected drive type.**
This error occurs if you attempt to open a configuration file that was created for a drive type that is not the currently selected drive type.
The connected drive is not supported.
This error is displayed if the CS3000 software attempts to connect to a drive that returns an unrecognized drive type.

Parameter(s) not relevant for the current control type found in the monitor list have been ignored.
This message is displayed if a monitor list is recalled that was used for a different control type than the one currently selected. Only parameters that are specific to the currently selected control type are displayed.

The file was created for an unknown drive.
This error is displayed if you attempt to open a configuration file that was created for a drive that is not recognized by the CS3000 software.

Communication error.
Can occur when the CS3000 software is communicating with the drive via the serial communication connection. Check the cables, drive power, and the COM port selection.

Parameter value is invalid.
Indicates a parameter value syntax error.

Parameter value has not been entered.
Indicates a missing parameter value.

Parameter value is out of range.
Indicates an out of range parameter value.

COMMUNICATION ERROR MESSAGES

Unknown response from the drive.
Displayed if the drive returns a response error code that is not recognized by the CS3000 software.

Operation cannot be performed while drive is running.
The operation that was attempted cannot be done if the drive is running. You must stop the drive to perform the operation.

Operation cannot be performed during download.
The operation that was attempted cannot be done if a download to the drive is in progress.

ID format is invalid.
Version format is invalid.
These messages indicate that the response to a request to the drive for its type and version is invalid.

A parameter VDR index was invalid.
If this error occurs, the CS3000 software attempted to read or write to a parameter with an invalid index number. This could indicate that the memory in the computer has been corrupted or that the CS3000 software itself is corrupted.

Download cannot be performed while the drive is running.
This message is displayed if a download is attempted when the drive is running. The drive must be stopped before a configuration can be downloaded.
Download cannot be opened. The drive is busy.
The drive is performing another operation. Wait a short amount of time and attempt the operation again.

Download cannot be performed. A network card is the control source.
Change the control source from the drive keypad to perform a download.

Variable processing errors occurred in the drive.
The drive had to change parameter values after a download was completed.

Parameter write errors occurred during download.
Some parameter values could not be written to the drive. This error indicates a problem in the CS3000 software or drive.

Parameter write attempted to a configurable parameter while drive is running.
Configurable parameters cannot be changed while the drive is running. The drive must be stopped to perform the intended operation.

Parameter value is out of range.
A parameter write was attempted with an out of range value.

Parameter could not be found in the drive.
The CS3000 software attempted to read the value of a parameter that is not in the drive.

The number of parameters in read is invalid.
The read request to the drive was invalid.

Read attempted with invalid parameter index.
The CS3000 software attempted to read a parameter that does not exist in the drive.

Invalid read message format.
The read message format created by the CS3000 software is invalid.

COM port is not available.
The selected COM port is not installed in the PC or is being used by a DOS application, such as the mouse driver.

COM port is being used by another application.
The selected COM port is being used by another Windows application.

Unable to read signal trace information from drive.
The CS3000 software could not read the information from the drive needed for the PC Scope. Check the drive connection.

Sample rate not supported.
Under some conditions in a drive, a sample rate may not be available for a PC Scope signal. Change the sample rate.

Failed to create status bar.
This error may be caused by a lack of memory. Close the application and retry.

Could not create toolbar.
This error may be caused by a lack of memory. Close the application and retry.
New Features in Version 6.1

Tuning for Vector-Controlled AC Drives

Chapter 5 describes how to tune vector-regulated GV3000 and Liqui-Flo drives.

PC Scope Improvements

- Grids can be turned on and off from the View menu.
- The T cursors and Y cursors can be turned on and off separately from the View menu or from the tool bar buttons.

![Toggles Y cursors]

![Toggles T cursors]
### Index

**A**
- About the Control and Configuration Software, 1-1
  - cables, 1-1
  - exiting the software, 2-10
  - hardware requirements, 1-2
  - intended audience, 1-3
  - menus, 2-7
  - overview, 1-1
  - purpose of this manual, 1-3
  - safety information, 1-3
  - software requirements, 1-1
  - starting the software, 2-5 to 2-7
  - terms used in this manual, 1-4
  - toolbars, 2-8 to 2-10
  - where to find additional information, 1-4
- Additional information, 1-4
- Audience, 1-3
- Auto Scale, 9-5
- ASCII, 9-11

**C**
- Cables, 1-2
  - Communication, set up
    - connecting the serial port, 2-3 to 2-5
    - selecting the communication port, 2-5
    - selecting the drive, 2-5
  - Configuring the Drive, 3-1
    - comparing the drive configuration to the opened configuration, 4-5
    - comparing the parameter values in the opened configuration with those in another configuration file, 4-4 to 4-5
    - creating a new configuration, 3-2
    - downloading a drive configuration, 4-2
    - editing a configuration, 3-7 to 3-10
      - assigning parameter values, 3-7 to 3-9
      - ending an editing session, 3-9
      - entering and editing a configuration description, 3-9 to 3-10
    - icons, 2-9
    - opening a drive configuration file, 3-3 to 3-4
      - different version of same drive, 3-5 to 3-6
    - printing a configuration, 3-12
    - saving a drive configuration, 3-12
- saving the open drive configuration to another file, 3-11
- selecting a drive, 3-1
- uploading a drive configuration, 4-1

**Controlling the Drive**
- connecting a drive, 8-1
- controlling a drive, 8-2 to 8-3
- disconnecting a drive, 8-1
- icons, 2-10
- monitoring drive indicators, 8-6
- selecting the,
  - control source, 8-4
  - direction of motor rotation, 8-4
  - reference mode, 8-4
- setting the,
  - drive reference, 8-4
  - jog reference, 8-5
- starting and stopping the drive, 8-5

**Cursors, 9-8**

**D**
- Description
  - configuration, 3-9

**Drive Parameters**
- adding to monitor list, 6-3
- assigning values, 6-4 to 6-6
- clearing monitor display, 6-8
- displaying a monitor list, 6-7
- exiting the monitor, 6-8
- overview, 6-1 to 6-2
- removing from monitor list, 6-3
- saving a monitor list, 6-6

**E**
- Editing
  - a configuration, 3-7 to 3-10
    - assigning parameter values, 3-7 to 3-9
    - configuration description, 3-9 to 3-10
    - ending an editing session, 3-9
  - drive parameters, 6-4 to 6-6
    - assigning values, 6-4 to 6-6
    - clearing monitor, 6-8
    - removing, 6-3
trace file,
   acquiring, 9-7
  clear the trace display and setup, 9-12
  changing views, 9-9
  opening a trace file, 9-12
  saving a trace file, 9-11
Error messages, 10-1

F
FlexPak 3000, 1-1, 1-3, 1-4, 4-2, 6-1, 8-2

G
GV3000, 1-1 to 1-4, 3-1, 3-3, 3-9, 6-5, 8-2, 8-6
tuning, 5-1 to 5-10
Getting assistance from Reliance Electric, 10-1

I
Installation
   before installing, 2-1
   completing, 2-2 to 2-3
   setting up communication, 2-3 to 2-5
Windows 3.1, 2-2
Windows 95, 2-2

J
Jog, 7-5, 8-5
Jog reference, 8-5

L
Liqui-Flo, 1-1 to 1-4, 3-1, 3-3, 3-9, 6-5, 8-2, 8-6
tuning, 5-1 to 5-10

M
Monitoring Drive Status and Alarms
   displaying and clearing the fault log and alarm
   log, 7-1 to 7-3
   drive status, 7-4 to 7-5
Menus, 2-7

N
Non-volatile memory, 7-5

O
Parameter Values
   adding, 6-3
   comparing, 4-3 to 4-5

PC Scope
   acquiring a trace, 9-7 to 9-9
   clear the trace display and setup, 9-12
   closing the PC Scope, 9-13
   changing views, 9-9
   icon, 2-10
   magnify the trace display, 9-10
   opening a trace file, 9-12
   overview, 9-1 to 9-4
   saving a trace file, 9-11
   set up a trace, 9-4 to 9-6
      specify signals, 9-5
      set up data sampling, 9-5
      set up the trigger, 9-6
   take a trace snapshot, 9-10
   take a snapshot, 9-10
   choose the trace snapshot colors, 9-10
   turn on and off cursors, 9-9
   work with cursors, 9-8 to 9-9
      move a cursor, 9-8 to 9-9
      specify the cursors to track each other, 9-9

Printing
   drive configuration, 3-12

R
restoring,
   default values to drive parameters, 7-5
   drive parameter values from non-volatile memory on the drive, 7-6

Requirements
   hardware, 1-2
   software, 1-1
RS-232, 1-3, 2-3 to 2-5

S
Safety, 1-3
Saving
   drive configuration, 3-10 to 3-11
   drive parameters, 7-5
   icon, 2-9
   monitor list, 6-5
to another file, 3-11
trace file, 9-11

Setup
communication, 2-3 to 2-5
drive reference, 8-4
jog reference, 8-5
trace, 9-3, 9-4
windows, 2-2
snapshot, 9-10
start, 8-5
stop, 7-3, 8-5

T
Terms used in this manual, 1-4
Toolbars, 2-8 to 2-10, 9-3
Trace files
acquiring, 9-7
clearing the display and setup, 9-12
magnifying, 9-10
opening, 9-12
saving, 9-11
setting up, 9-4 to 9-6
  specifying signals, 9-5
  setting up data sampling, 9-5
  setting up the trigger, 9-6
taking a snapshot, 9-10
taking a snapshot, 9-10
choosing the trace snapshot colors, 9-11
Trigger, 9-6
Troubleshooting
  getting assistance from Reliance Electric, 10-1
  using error messages 10-1
Tuning GV3000 and Liqui-Flo Drives
  standard, 5-2 to 5-4
  custom, 5-5 to 5-10

Z
Zoom, 9-3, 9-9